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HOUDINI FOUNDATIONS

概要
映画、テレビ、ビデオゲーム、VR 向けに 3D アニメーションや VFX を作成する
には、技術的なスキルはもちろん、創造的なスキルも必要です。Houdini は、
これらの世界を 1 つにまとめるのに最適なツールです。コンセプトから最終
的な仕上げまで、プロジェクトを探求、創造、洗練させていくことができます。 

Houdini には、CG コンテンツの生成用に設計されたさまざまなツールが備
わっていますが、Houdini ならではの特徴が、ノードベースのプロシージャル
なワークフローです。このアプローチなら、制御可能なショットの作成、複数
回のイテレーション、期限の遵守の達成が容易になります。Houdini を学習
するときには、ノードやネットワークの扱い方を理解することが成功へのカギ
です。

学習内容
	� この「概要」の章では、重要なコンセプトやアイデアを理解するのに役立つ、

Houdini の基本情報を紹介します。はじめからすべてを理解するのは難し
いでしょう。この章を参照しながら、Foundations チュートリアルを進め、
知識を積み上げていってください。

	� 3D ソフトウェアの使用経験がある方は、そこで培ったスキルを活かせます。Scene View とシェルフツールを
使ってインタラクティブにショットを構築する方法を学んでから、Houdini のプロシージャルな性質を利用する
ためのノードやネットワークの使い方に進みます。 

3D やコンピュータグラフィックスに初めて触れる方にも、Houdini はぴったりのパッケージです。この学習教材
「Foundations」は一定の基礎知識があることを前提としているため、知らない CG の概念については、調べなが
ら読み進めることをお勧めします。Houdini を学習すると、Houdini だけでなく、3D アプリケーション一般につい
て、内部で何がなされているかについての理解が進みます。

「Foundations」のチュートリアルを完了したら、SideFX.com には他のチュートリアルもあります。ぜひ挑戦してく
ださい メインメニューで Learn > Learning Paths を選択すると、SideFX および Houdini コミュニティのメンバー
が作成したレッスンの一覧を確認できます。たくさんのレッスンを用意していますので、Houdini のスキルアップに
お役立てください。

HOUDINI を 
無償でダウンロードする
SideFX が提供する学習用体験版で、レッスン
を実行できます。体験版 Houdini Apprentice 
なら、Houdini の機能を無償で利用できます。 
ただし、レンダリング解像度やユーザインター
フェースの制限、ウォーターマークの追加など、 
制約事項がいくつかある点に留意してください。 
Houdini Apprentice は、SideFX の Web サイトで
ダウンロードできます。定期的に更新される最新
バージョンも、この Web サイトで提供しています。
SideFX.com/download

 独立系のアニメータおよび 
ゲーム開発者
学習用体験版では物足りない方には、Houdini 
Indie がお勧めです。Apprentice のようなウォー
ターマークが追加されないうえ、最大 4K x 4K の
高いレンダリング解像度が可能です。商用利用に
ついては、約 1000 万円以下の収益の用途に制限
されます。 
この Indie ライセンスにより、Houdini は個人プ
ロジェクトやインディゲームの開発に最適なツー
ルとなっています。詳細は以下をご覧ください。 
SideFX.com/indie
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Houdini では、すべてがプロシージャルです。つまり、モデリング、 
キャラクタリギング、ライティング、レンダリング、ビジュアルエフェクト
のすべてにおいて、ノードベースのワークフローの恩恵を受け、ノード 
ネットワークを構築するだけで、クリエイティブなタスクに必要とされ
るすべての手順を実行できます。ネットワークは他のネットワークと

「通信」でき、それによってさらに複雑なシステムを構成します。

プロシージャル
Houdini では、ユーザのすべてのアクションがノードとして格納されま
す。ノードはネットワークに「接続」され、「レシピ」を作ります。レシピ
を微調整して繰り返し可能な成果を定義でき、イテレーションごとに 
ユニークな結果を得ることができます。重要な情報をアトリビュートと
いう形で下流に渡すことができるノードの機能が、Houdini のプロシー
ジャルな性質を支えています。

VFX が得意
Houdini がビジュアルエフェクトアーティストを魅了し続けているの
は、パーティクルやダイナミクスを扱うには、このプロシージャルな 
ワークフローが理想的だからです。ビジュアルエフェクトはたいてい、
ショット内で起きるアクションに反応するよう設計されており、プロシー
ジャルなソリューションがそうした反応を「自動化」します。Houdini を
使用すると、スタジオの生産性が向上し、制作プロセスをより詳細に
制御できるようになります。

Houdini はまた、大規模なデータセットを扱えるため、リジッドボディ
の破壊、流体、パーティクルなど、多数のレイヤーが相互作用して 
最終的な結果が作成される、複雑なビジュアルエフェクトにも対応で
きます。

プロシージャルな表現
モーショングラフィックスのプロジェクトでは、プロシージャルなアプ
ローチによって、視覚的に魅力的なエフェクトを豊富に作ることができ
ます。こうした特殊効果の多くは、ノード上でパラメータをアニメート
し、現実にはありえないような面白い方法でノイズを追加することで 
得られます。

幅広い CG パイプライン 
VFX とモーショングラフィックスだけではありません。Houdini は、モデ
リングからレンダリング、キャラクタ制作からゲーム開発まで、パイプラ
インのあらゆる部分に対応できる基本ツールを備えています。Houdini 
のプロシージャルなワークフローは、あらゆる CG コンテンツの作成を
サポートします。その過程では、複数のイテレーションを検討したり、
細部にわたって変更を加えることもできます。

ノードは Houdini ならではの特長であり、パワーの根源ですが、 
ビューポートやシェルフツールも豊富に用意されています。それらを 
インタラクティブに使用しながら、Houdini でネットワークを構築する
ことができます。

Houdini について
Houdini は、モデリング、アニメーション、レンダリング、シミュレーションに使用できる CG（コンピュータグラフィッ
クス）アプリケーションです。Houdini を学習しながら、ノード、ネットワーク、アセットをインタラクティブに操作する
という、制作プロセスの新しい制御方法を探求していきます。
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結果の制御しやすさ
プロダクションの細部まで編集できるのは、Houdini のノードでパラ
メータに変更を加えると、ネットワークを通じて次々に変更が伝達さ
れ、結果が更新されるからです。この制御しやすさは制作プロセス全
体で維持されるため、土壇場で決断をしても、従来の CG パイプライン
のようなコストはかかりません。

ツールの構築
ノードベースのアプローチのもう 1 つの利点は、ノードネットワークを
カプセル化してカスタムノードを簡単に作成できることです。コードを
書く必要もなく、同僚と共有できます。Houdini の再利用可能なネット
ワークは、Houdini Digital Asset と呼ばれる特別なノードに、手間
をかけずに簡単にラップできます。

これらのアセットは、Houdini はもちろん、Autodesk Maya、 
3ds Max、Unreal、Unity などの他のアプリケーションでも Houdini 
Engine プラグインを使用して開けます。アセットのプロシージャルな
性質もそのまま保たれます。

 

全データへのフルアクセス
一般的なアニメーションまたはビジュアルエフェクトのパイプラインで
は、オブジェクトに情報が蓄積されていきます。通常は Velocity、キャ
プチャウェイト、UV テクスチャ座標などのポイントまたはプリミティブ
アトリビュートとして保存されます。他の 3D アプリケーションはこの 
情報を隠し、舞台裏で制御しようとしますが、Houdini にはこうした
データを使用および管理できるツールが備わっています。はるかに 
パワフルで柔軟なアプローチが可能となるため、プロダクション全体
が大きく改善します。

新しい考え方
Houdini を使い慣れると、ショットやゲームレベルに新たな方法でアプ
ローチできるようになり、個人およびチームの生産性が向上します。 
柔軟性に優れた Houdini では、プロジェクトのライフサイクル全体を
サポートするツールを構築できます。また、問題や課題に対処するだ
けでなく、弱点を予測し、さらなる効率化を実現するプロシージャルな
ソリューションを利用できます。 

Andriy Belichenko

Houdini を学ぶことは、今後のプロジェクトへのアプローチ方法を 
再定義するような、多目的なアプリケーションを探求することです。 
この新しい考え方を受け入れ、想像以上の深いレベルで CG の世界を
探求しましょう。 

Houdini ではコードを書く必要がありますか?
いいえ、書く必要はありません! それどころか、他の 3D アプリケーションならコードを書かなければ得られない結果を、
Houdini のノードベースのワークフローのおかげでインタラクティブに作れることもよくあります。Houdini はまさに 
アーティストのためのツールです。スクリプトやエクスプレッションを使用する技術的な側面もありますが、備わっている
ツールだけで驚くべき成果を得られます。また、ノードの仕組みのおかげで、創作プロセスにつきものの試行錯誤も簡単
に行えます。 
コードで作業したい方には、Houdini は Houdini インターフェース内で多くの言語をサポートしています。Wrangle ノード
では VEX と Python を使用でき、PyQT もサポートされています。Houdini のエクスプレッション言語である HScript も 
使用できるうえに、特定のニーズに合わせて混用することも可能です。
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Houdini ワークスペース
Houdini のユーザインターフェースは、他の CG アプリケーションを使用してきたアーティストには馴染みやすい 
でしょう。最大の違いは、ノードとネットワークを管理するペインです。ワークスペースはさまざまに設定可能で、 
作業方法に合わせてセットアップすることができます。

Houdini は、3D シーンを構成する各種要素をさまざまな方法で表示
できます。カメラ越しにジオメトリを見る Scene View や、プロシージャ
ルノードとネットワークを管理するネットワークビューなどを使用して、
各ショットが技術的に機能することを確認しながら、クリエイティブな
決定を下すことができます。 

Radial メニュー
Houdini のツールにアクセスする方法の 1 つに、X、C、V のホットキー
を使ってアクセス可能な Radial メニューがあります。いずれかのホッ
トキーを押すと、Radial メニューが表示され、各種オプションを選択で
きます。各メニューの主な内容は次の通りです。

	� スナップ 	 X
	� メイン 	 C
	� ビュー	 V

Radial メニューの仕組みを理解すると、ウィジェットに頼らずに、 
素早くマウスカーソルを動かすだけでツールにアクセスできます。 

デフォルトで Main と表示されている、メニューバーの上部のカスタム
メニューを変更できます。OS X では、これが Radial メニューです。

シェルフツール
ワークスペースの上部には複数のシェルフがあり、オブジェクト、 
ジオメトリ、カメラ、ライト、エフェクトを作成したり操作できるツール
が多数搭載されています。

これらのツールは Scene View で機能し、多くの場合、何らかの相互
作用を伴います。ツールを使用すると、1 つまたは複数のノードが作成
され、パラメータエディタやネットワークエディタで微調整することが
できます。 
シェルフは、Houdini を使い始めたばかりのアーティストには非常に
重要なリソースです。クリック回数を減らすことができ、配置された 
ノードのネットワークからさまざまなことを学べるためです。

タブメニュー
Scene View またはネットワークビューでツールにアクセスするもう  
1 つの方法が、Tab キーです。利用可能なツールやノードのメニューが
表示されます。

入力を開始すると、 
対応するツールがメニューに 
表示される

ツールシェルフ - シェルフツールを使用すると、Scene 
View でオブジェクトやジオメトリを操作できます。
ツールバー :
選択モード - シーン、ジオメトリ、またはダイナ
ミックオブジェクトにフォーカスします。

選択ツール - Select、Secure Selection。

トランスフォームツール - ノード固有の 
コントロール用の Move、Rotate、Scale、Pose、 
または Handle ツール。

スナップツール - グリッド、プリミティブ、 
ポイントへのスナップと複数スナップを 
オンにします。
ビューイング - View ツールを使用してタンブル、 
パン、ドリーしたり、Render Region ツールを使用し
て Scene View でレンダリングできます。クリックした
ままにすると、2D パン/ズームに変更できます。

出力ツール - これらのツールを使ってシーンを 
レンダリングしたり、フリップブックを作成できます。
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 3D View ツール
ビュー操作で使用できるホットキーの組み合わせをいくつか紹介しま
す。実際に View ツールを使用している間は、スペースバー/ Alt を 
省略できます。

	�  タンブル	 スペースバーまたは Alt（Opt）+ 左マウスボタン（LMB）
	�  パン	 スペースバーまたは Alt（Opt）+ 中マウスボタン（MMB）
	�  ドリー	 スペースバーまたは Alt（Opt）+ 右マウスボタン（RMB）

View ツールはツールバーにあります。スペースバーまたは Alt キー
を押すと、一時的に View ツールを呼び出すことができます。ビューで 
選択または操作しているときに、視点を素早く変更したい場合には
非常に便利です。 
ビューイングに集中したい場合は、Escape を押すと View ツールに 
移動できます。ビューの操作に使用できる便利なホットキーをいくつか
ご紹介しておきましょう。

	� Home Grid	 スペースバー + H
	� Home All 	 スペースバー + A
	� Home Selected 	 スペースバー + G

 2D パン/ズーム
オペレーションコントロールツールバーにある 2D パン/ズームツール
をクリックすると、3D カメラの位置を変えることなく、2D でのビューを
変更することができます。左上のウィジェットでは、クリックしてパンや
ズームしたり、Ctrl + LMB クリックでビューをリセットできます。これ
は、ロックされたカメラで作業する際に便利なツールです。 

2D パン/ズームウィジェット

Ctrl + LMB でリセット

2D パン/ズームボタン

2D パン/ズーム

LMB ドラッグでパン 
MMB スクロールまたは 
RMB ドラッグでズーム

 一人称視点のカメラ
View ツールでは、ビデオゲームで目にするような、一人称視点の 
フライスルーモードをオンにできます。

	� 一人称視点のオン/オフ	 M
	� ドリーイン/ドリーアウト	 W/S 
	� 右にパン/ 左にパン	 A/D
	� 視点を回転	 LMB

ビューポートディスプレイメニュー
Scene View の右上にあるメニューまたは V Radial メニューを使用し
て、オブジェクトの表示方法やビューの構成を変更できます。

シェーディングメニュー
オブジェクトディスプレイメニュー

ビューメニュー

シェーディングメニュー - Wireframe、Flat Shaded、Smooth 
Shaded、Smooth Wire Shaded などのオプションがあります。
オブジェクトディスプレイメニュー - ネットワーク内に入ったとき、 
ジオメトリを非表示にするか、表示するか、ゴースト表示するかを設定
します。 
ビューメニュー - Scene View をパースビューや正射投影ビューなどの
さまざまなビューに分割できます。

Display Options バー
Scene View の右側にある Display Options バーでは、ビューポート表
示のオプションにアクセスできます。いくつかをご紹介しましょう。

 Reference Plane/Ortho Grid - 参照用やグリッドスナッピングに
使用できるグリッドをオン/オフします。 

 Construction Plane - オブジェクトやポイントの配置場所を定義
するのに使用されるコンストラクション平面をオン/オフします。 

 Lock Camera - 現在のカメラをビューに固定して、ビューを変更
するとカメラのトランスフォーム値も変更されるようにします。

 High Quality Lighting with Shadows - ビューポートレンダリン
グの最高画質を設定します。

 Display Primitive Normals - シーンのすべてのプリミティブに 
属する法線を表示し、その方向を特定します。

Display Options
Scene View とネットワークビューには、それぞれ Display Options  
パネルがあり、Display Options バーの下部にあるアイコンをクリック
することでアクセスできます。

  Display Options 	 D

ビューポートディスプレイメニュー - オブジェクトの表示方法やビューの
構成を変更できます。
ペインタブ - これらのタブを使用すると、複数のパネルを同時に作成し
たり整理できます。
オペレーションコントロール - このツールバーと Handle ツールを使用
すると、選択したノードのパラメータにアクセスできます。
パラメータエディタ - 選択したノードに値を設定したり、エクスプレッショ
ンを追加したり、キーフレームを設定することができます。
Display Options バー - 法線、ポイント番号、ライティングといった 
シーンのディスプレイオプションを制御できます。
Scene View - 作業内容を視覚化したり、ハンドルを使ってシーン内の 
オブジェクトをインタラクティブに操作できます。
ネットワークエディタ - ノードのネットワークを表示したり管理して、 
シーンの基礎構造を操作できます。
プレイバー - 選択したノードで現行時間を設定したり、キーフレームを 
編集できます。プレイバーを使用すると、キーフレームをコピーアンド
ペーストすることもできます。
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ペインとデスクトップ
Houdini ワークスペースは、シーンデータをユニークな方法で編成した、いくつかのペインに分かれています。 
3D ビューでインタラクティブに作業したり、スプレッドシートでアトリビュート値を分析することもできます。 
こうしたさまざまな UI 要素を有効に利用する方法を学ぶことが重要です。

ペインとペインタブ
Houdini ワークスペースはペインに分割されており、シーンをセット
アップしたり探求できるようになっています。ペインタブを使用すると、
同じゾーン内に複数のペインをオーバーラップさせて、便利な状態に
保つことができますが、デフォルトでは表示されません。
ワークスペースでペインタブをクリックすると、そのペインタブにアク
セスできます。閉じるには X をクリックします。+（プラス）メニューを 
使用すると、表示されているペインを変更したり、新しいペインを追加
することができます。 

ペインタイプ
ペインタブを RMB クリックして、タイプを変更します。たくさんのペイ
ンタイプから選択できます。一部のタイプにはホットキーがあります。
他のタイプのいくつかも、ここにリストしました。すべてのタイプについ
て詳しく確認するには、別途ドキュメントを参照してください。

Network View（Alt + 2） - このビューでは、ノードやネットワークを確認した
り、ニーズに合わせて接続、再接続、再編成を行うことができます。
Parameters（Alt + 3） - パラメータに値を設定したり、エクスプレッションを
追加したり、ノードのプロパティを制御することができます。
Tree View（Alt + 4） - ノードを階層表示します。これは、シーン階層を理解
するのに便利です。

Viewers > Scene View（Alt + 1） - 3D 空間でインタラクティブに作業でき
ます。このタイプのビューでは、1 つまたは複数のビューポートをセットアップ
できます。複数の Scene View パネルを同時に開いて、さまざまな視点から
シーンを見ることが可能です。 

Composite View（Alt + 0） - Compositing（COP）ノードを使用して作成され
た画像やコンポジットを表示します。
Viewers > Motion FX View（Alt + ^） - Houdini のチャンネルオペレータ

（CHOP）ノードを使用して作成されたモーションを表示します。 

Solaris > Scene Graph - Solaris（LOP）ノードを使用する際、USD シーング
ラフを表示します。
Solaris > Render Gallery - テストレンダリングを保存し、すべての画像を
確認した後、各画像の設定に戻すことができます。
Solaris > Light Linker - ライトとオブジェクトを接続します。

Render Scheduler - 完了したレンダリングや進行中のレンダリングを表示し
ます。レンダリングを停止したり、強制終了することができます。
Material Palette（Alt + 7） - シーン内のすべてのマテリアルを表示し、オブ
ジェクトやジオメトリに割り当てることができます。

Animation > Animation Editor（Alt + 6） - キーフレームとアニメーション
カーブを管理できます。アニメーションエディタには、テーブルビューとドー
プシートビューもあります。

Animation > Channel List - チャンネルグループを作成し、Houdini でアニ
メートする際にスコープされたチャンネルを管理できます。
Animation > Autorigs - 二足リグ、四足リグ、フェイシャルリグ用に、独自の
リグをモジュールから構築できるツールにアクセスできます。
Animation > Character Picker - このペインを使用すると、キャラクタリグ
のパーツを簡単に選択できるようになります。
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Inspectors > Geometry Spreadsheet（Alt + 8） - ジオメトリのアトリビュー
ト値を表示します。UV、法線、独自に設定したカスタム値などが含まれます。
Inspectors > Data Tree - Light Bank、Material Stylesheet、Object 
Appearance エディタにアクセスできます。

Mantra Rendering > Render View（Alt + 9） - インタラクティブな Mantra 
レンダリングを開始します。シーン内で変更を加えると、更新されます。
Mantra Rendering > Take List - 特定のパラメータを変更することで、 
さまざまな「テイク」を探求できます。テイクを管理して、気に入ったものに
フォーカスできます。

TOPS > Task Graph Table - グラフ内のすべてのワークアイテム、または 
特定のノードのすべてのワークアイテムのメタデータを表示します。

Misc > Orbolt Asset Browser - Orbolt.com のアセットにアクセスできま
す。このペインを使用するには、orbolt.com アカウントでログインする必要
があります。

Misc > Textport - コマンドを入力できます。
Misc > Python Shell - Python コマンドを入力できます。

ペインの整理と折り畳み
ペインとツールバーは、それぞれの UI にある矢印をクリックすること
で、折り畳んだり展開することができます。ペイン全体は左右に折り畳
むことができ、中央のグリップを使用すると、内容を反転させることも
できます。これらのオプションにより、マウスを 1 回クリックするだけで
他のペインを非表示にし、特定のペインにフォーカスすることが可能
です。

ここをドラッグして分割線を移動 

ここを LMB クリックして上に折り畳む

ここを LMB クリックして下に折り畳む

ここを LMB クリックしてペインを反転
Alt + LMB クリックして向きを反転

ペインメニュー
各ペインの左上には、ペインを最大化、最小化するためのボタンと、
ペインメニューにアクセスするための矢印が表示されています。 
このメニューでは、ペインやペインのコピーを切り離したり、ペインの
削除や分割を行うことができます。また、各ペインの UI を決めるため
のオプションもあります。

デスクトップ
タブを開き、分割線を追加し、ペインタブを整理していくと、自分なり
のワークスペースをセットアップできます。レイアウトを保存するには、
Desktop メニュー（OSX では Windows > Desktop）を使用します。 
このメニューでは、保存したデスクトップにアクセスしたり、独自のデ
スクトップを保存したり、作業中にデスクトップを管理することができ
ます。デスクトップを保存すると、ペインレイアウト、Radial メニュー、
表示されているシェルフセットが保存されます。

シーンを保存した場合、どのデスクトップを見ているかは記憶されま
すが、作業中にペインレイアウトに加えられた変更は記憶されません。
明示的にデスクトップに保存するか、新しいデスクトップを作成しない
限り、これらの変更は消えてしまいます。 

シェルフとシェルフセット
ワークスペースの上部にあるシェルフを管理するには、矢印アイコン
の下に表示されるメニューにアクセスします。このメニューを使用し
て、シェルフセットを操作できます。また、非表示になっているシェルフ
セットをデスクトップに表示させることもできます。

カラー設定
ワークスペースのカラースキームを選択することで、Houdini UI の 
外観をカスタマイズできます。Edit > Color Settings を選択して
オプションウィンドウを表示し、デフォルトのHoudini Dark または 
Houdini Light を選択します。ダウンロードボタンをクリックして、
Houdini コミュニティで作成されたカラースキームのリストから選択し
てもかまいません。 
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ノードとネットワーク
Houdini のノードベースのワークフローは、プロシージャルなアーキテクチャの中核です。Houdini を有効活用する
ためには、これらのノードやネットワークを直接操作できることが非常に重要です。ノードというと専門的に聞こえる
かもしれませんが、実際には非常にアーティストフレンドリーで、使いやすい仕組みです。

Houdini でツールを使用すると、ノードが作成され、他のノードに接続
されます。できあがったネットワークでは、ユーザアクションの履歴が
分かるうえ、変更や微調整を簡単に加えられます。Houdini で作業す
るうえでは、ノードネットワークの効果的な使用方法を学ぶことが重要
です。 

ノードフラグ
各ノードには、表示されているか、ロックされているか、バイパスされてい
るかを表すさまざまなフラグがあります。フラグそのものをクリックするか、
Radial ノードメニューを使用して、フラグを設定できます。

Bypass の切り替え

情報ボックス

Freeze の切り替え

Display の切り替え

Template の切り替え

 Display フラグ （R） - このフラグを使用すると、表示させる出力ノードを
選択でき、ノードは中空のリングでハイライトされます。

Render フラグ （T） は、レンダリングに出力されるノードを設定します。その
ノードは塗りつぶされた円でハイライトされます。Display フラグとは別にこ
れを設定するには、Display フラグを Ctrl クリックします。

 Template フラグ （E） - このフラグは、ノードをグレーで表示します。 
参照やスナップに使用することができます。 

 Freeze フラグ - ロックされたノードでキャッシュ化します。ネットワーク
がクックされるとき、チェーン内の前のノードはすべて無視されます。

 Bypass フラグ （B） - ネットワークがクックされるとき、このフラグを設定
したノードは無視されます。 

ノードの接続と接続解除
ビューポートで作業するとき、多くの場合、ノードは自動的に配置、 
接続されます。ネットワークを再編成したい場合は、ノードの接続と 
接続解除を手動で行う必要があります。
ネットワークエディタでノードを扱ったり接続する方法をいくつか紹介
します。

	� ノードの接続 	 出力から入力を LMB ドラッグ
	� 複数ノードの接続	 J を押しながら複数のノード間をドラッグ
	� 新しいノードの挿入 	 出力またはワイヤー上を RMB
	� ノードの挿入	 LMB ドラッグしてワイヤー上にドロップ
	� ワイヤーからの接続解除 	 LMB でノードを選択して振る
	� ワイヤーの切断	 Y を押しながらワイヤーを横切るようにドラッグ
	� ノードの移動	 LMB ドラッグ
	� 選択したノードのコピー	 Alt + LMB ドラッグ
	� 参照コピー	 Alt + Shift + Ctrl + LMB ドラッグ

ドットを使ってネットワークを整理できます。
	� ドットの追加 	 ワイヤーを Alt + LMB
	� ドットのピン留め /ピン解除	 ドットを Alt + LMB

ノードギャラリー
ギャラリーでは、ネットワークに直接追加したいノードに素早くアクセ
スすることができます。ギャラリーには、日常の作業でよく使用するノー
ドが含まれており、すべてのノードに Tab キーでアクセスできます。
Windows > Gallery Manager を使用して独自のギャラリーを作成し
たり、ノードを RMB クリックしてから Save to Gallery... を選択する
ことで、ギャラリーにアイテムを追加できます。 
Mat ネットワークに保存されたノードは、Mantra マテリアル用の 
Mantra  のように適切なキーワードが用いられている限り、Material 
Palette でも利用可能です。

ネットワークパス - 現在のネットワークレベルまで
のパス。このバーを使用して他のネットワークに 
移動することも可能です。

ペインメニュー - ネットワークを整理するための 
メニューとアイコン。

ネットワークの背景 - ペインメニューを使用して、
画像を追加したりグリッドをセットアップし、 
ノードを整理しやすくすることができます。

ネットワークボックス - 関連するノードをグループ
化します。素早く折り畳んだり展開することができ
ます。

ステッキーノート - メモを追加して、他のアーティ
ストがネットワークを簡単に理解できるようにした
り、説明を加えたりします。

ノードギャラリー - ここからネットワークにノードを
ドラッグできます。下部のフィルタを使用して、 
必要なノードを見つけられます。

ネットワークビュー

8

HO
UD

IN
I F

OU
ND

AT
IO

NS



ネットワークタイプ
Houdini にはさまざまな種類のノードがあり、それぞれが独自のコン
テキストで機能します。ネットワークタイプは、ネットワークビューの右
上に表示されます。各タイプのノードは、他のネットワークに接続する
ことができます。ノードタイプが違っても接続方法は同様ですが、それ
ぞれ固有の働きをします。

	� シーン	 オブジェクト 	 OBJ
	� ジオメトリ	 サーフェスオペレータ	 SOP
	� Solaris	 ライティング/レイアウトオペレータ	 LOP
	� マテリアル	 VEX Builder 	 MAT
	� Motion FX	 チャンネルオペレータ	 CHOP
	� VEX	 VEX Builder	 VOP
	� 出力	 レンダリングオペレータ	 ROP
	� タスク	 タスクオペレータ	 TOP
	� ダイナミクス	 ダイナミクスオペレータ	 DOP
	� コンポジット	 コンポジットオペレータ	 COP/IMG

Houdini を使い続けるうちに、このノードタイプを語る「秘密」の言語を
理解し、それをプロシージャルに適用する方法が分かるようになるは
ずです。

ネットワークパス
ノードは階層的に編成されており、ネットワークマネージャまたはサブ
ネットワークと呼ばれる、別のノードにネスト化されている場合もあり
ます。これらの階層を管理しやすくするために、ほとんどのペインの上
部にはブラウザのようなパスが表示されています。

親ノード

バック/フォワードボタン

パス階層

パスの 
ピン留めコンテナノード

  ターゲットを別のペインにドラッグ

このパスを使用して、階層を上下に移動したり、他のネットワークに 
移動することができます。デフォルトでは、Scene View で選択すると 
パスが変化しますが、パスをピン留めしてフォーカスを保持することも
可能です。また、ピン留めしたペインにターゲットアイコンをドラッグ
し、パスを同期させることもできます。 

ネットワークナビゲーション
ネットワークタイプ間の移動には、さまざまな方法があります。Scene 
View でオブジェクトを操作しながら自然の流れで行う方法もあれば、
素早く移動できるショートカットカットもあります。 

選択モード - Scene View で選択すると、ネットワークエディタが選択
した位置にジャンプします。選択モードによって、選択する際のネット
ワークタイプが変化します。
ネットワークパス - 親ノードを LMB クリックして、上のレベルに移動
できます。コンテナノードを LMB クリックすると、同じレベルのノード
にアクセスしたり、他のコンテナノードの中に入ることができます。

Radial メニュー - N を押して Radial メニューを開き、ネットワーク内を上下
に移動したり、別のネットワークタイプに移動することができます。
ホットキー - 以下のホットキーを使ってネットワーク内を移動しながら、選択
したオブジェクトを使用できます。

	� ノードの中に入る	 I
	� 上のレベルに移動する	 U
	� オブジェクト/ ジオメトリを切り替える	 F8
	� 前または次のネットワークに切り替える 	 Alt +  または Alt +  

クィックマーク - ネットワークロケーションを設定して、素早くその 
ロケーションに戻ることができます。必要に応じて使用でき、後で上書
きも可能です。忘れても問題ありません。シーンファイルには保存され
ません。

	� クィックマークの設定 	 Ctrl + 1, 2, 3, 4 または 5
	� クイックマークに戻る 	 1, 2, 3, 4 または 5
	� 前のビューに戻る	 `

選択と表示のホットキー
ネットワークエディタでは、パンやズームしながらネットワーク全体を
操作する必要があります。これらのアクションに使用するキーの組み
合わせを紹介します。

	� パン 	 MMB
	� ズーム	 RMB
	� ノードの選択 	 LMB
	� 追加選択 	 Shift + LMB
	� 選択解除 	 Ctrl + LMB

ノードを詳しく知る
Radial メニューを使用するか、 
ノードをMMB クリックして情報ボッ
クスを表示します。このパネルでは、
ノードの内容、グループ、 
アトリビュートに関する情報や、 
その他の重要事項について確認で
きます。また、ワークフローに影響
しているエラーも表示されます。

このパネルは自動的に閉じますが、
ピンアイコンをクリックすると、 
作業中も表示したままにできます。
このパネルを使ってコメントを追加
し、ネットワークビューに表示させ
ることができます。 

ノード - ネットワークの最終出力に寄与するオペレーショ
ンを表します。

ネットワークタイプ - どのネットワークタイプで作業して 
いるかを示します。

ワイヤー - どのようにノード同士がつながり、どのように 
データがネットワーク内で渡されているかを示すラインです。

ドット - ドットを追加すると、ノードを整理しやすくなります。

表示リング - この小さい円は、Scene View にどのノード
が表示されているかを示します。

レンダーリング - この大きい円は、表示されているノード
に関係なく、レンダリングノードを示します。

コメント - 他のアーティストがネットワークを理解しやすい
よう、ノードのコメントを表示できます。

パレット - メニューのボタンを使用して、ノードの色や形状
を設定できるパレットを表示できます。 
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パラメータ、チャンネル、アトリビュート
Houdini のすべてのノードは、希望の結果が得られるよう、パラメータ、チャンネル、アトリビュートによって 
駆動されます。Houdini で使用されている用語は、他の3Dアプリケーションとは異なる場合があります。 
時間をとって、Houdini での用語の意味を理解することをお勧めします。

パラメータ
パラメータとは、Houdini ノードの値、スライダ、ボタン、チェックボッ
クスのことを指します。これらは他のアプリケーションでアトリビュート
と呼ばれる場合もありますが、Houdini ではアトリビュートを別の意味
で使用します。
パラメータ値は、パラメータエディタで、またはビューポートでハンドル
を使用して変更することができます。各パラメータには RMB メニュー
があり、コピー、ペースト、デフォルトに戻すといった重要なオプション
が多数用意されています。

 パラメータの検索
ノードには多数のパラメータがあり、すべてを見ていくのは時間がかか
ります。右上の虫眼鏡をクリックすると、検索バーが表示され、名前と
内容に基づいてパラメータをフィルタリングできます。エクスプレッショ
ン、オーバーライド、さらにはパラメータ値そのものを使用して、パラ
メータを見つけることができます。

チャンネル | キーフレーム
パラメータにキーフレームを設定するには、Alt キーを押しながら、 
名前または値のフィールドを LMB クリックします。キーフレームを 
設定すると、パラメータのフィールドの色が変わり、アニメートされた
チャンネルが作成されます。キーフレームがパラメータに関連付けら
れ、アニメーションエディタでアクセスできるようになります。

チャンネル | エクスプレッション
値そのものではなく、hScript  または Python  を使用して、パラメータ
にエクスプレッションを追加することもできます。パラメータエディタの
右上に、使用する言語を選択できるメニューがあります。Ctrl + E を 
押すと、スクリプトツールを多数備えたエクスプレッションエディタが
表示され、作業が容易になります。

シーンデータの参照
パラメータを RMB クリックして、Reference > Scene Data を選択す
ると、参照したいものを具体的に選択できるウィンドウが表示されま
す。シーン内の任意のノードから選択して、チャンネル参照を作成でき
ます。この方法なら、正確な構文で適切なエクスプレッションを書く苦
労なしに、参照を作成できます。

ナビゲーションバー - このバーでは、ノードがシーン
階層のどこに位置しているかを確認できます。
ノードのタイプと名前 - ノードタイプとノード名が 
表示されます。アイコンをクリックすると、ノードを
使用するためのメニューが表示されます。
検索バー - 虫眼鏡のアイコンをクリックすると、 
名前や内容でパラメータを検索できます。
パラメータの変更 - パラメータがデフォルトから 
変更されると、値が太字で表示されます。フォルダ 
タブ名も太字になります。
アニメーションパラメータ - パラメータにキー 
フレームを設定すると、緑でハイライトされます。
パラメータのロック - パラメータを RMB クリックして、 
ロックしたりロック解除できます。グレーでハイライト 
されます。
選択してマッチ - これらのアイコンを使用すると、 
パラメータ値を他のオブジェクトにマッチさせる 
ことができます。 

パラメータエディタ
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カスタムパラメータ
パラメータエディタの右上にあるギアアイコンをクリックすると、 
Edit Parameter Interface を選択できます。このウィンドウでは 
カスタムパラメータを追加して、ノードネットワークの他の部分に 
リンクすることができます。

アトリビュート
アトリビュートを使うと、ジオメトリにデータを取り付けられます。 
そのデータは、オペレーションを完了するまでチェーン内のノードで
順に使用されます。fuel アトリビュートは Pyro FX シミュレーションを
駆動し、UV アトリビュートはテクスチャリングをセットアップします。
Houdini ノードによって作成されるアトリビュートも、独自に作成する
カスタムアトリビュートもあります。 

クラス - アトリビュートは、ポイント、プリミティブ、ディテール、頂点に属し
ます。これは、チェーンでどのように使用されるかに影響します。 
タイプ - 浮動小数点、整数、文字列のアトリビュートタイプをセットアップでき
ます。

ATTRIBUTE RANDOMIZE
Attribute Randomize を使用すると、アトリビュートを作成し、その値
を即座にランダム化することができます。例えばこの例では、ボックス
の色、回転、スケールがランダム化されています。 

Attribute Transfer
ノードチェーン内で、アトリビュートはジオメトリに取り付けられ、 
他のノードでも使用されます。Attribute Transfer を使用すると、 
他のジオメトリピースにアトリビュートを渡すこともできます。この例で
は、球が定義された閾値に基づいて、ボックスにカラーアトリビュート
を渡しています。 

ATTRIBUTE WRANGLE
Houdini には、アトリビュートを作成したり使用するための多様な 
ノードがあります。Attribute Wrangle ノードを使用すれば、スクリプ
トベースのアプローチを取ることも可能です。これは、多くのテクニカ
ルディレクタが非常にやりやすいと感じる方法でしょう。 

アーティストにとっては、ノードを使用した方がこうした情報を扱いや
すいものです。Houdini を有効活用するには、アトリビュートを適切に
使用することが重要であり、いずれはアトリビュートについて学ぶ必要
がある時がきます。

Geometry Spreadsheet
Geometry Spreadsheet では、非表示のものも含め、 
すべてのアトリビュート値を確認できます。

ナビゲーションバー - このバーでは、ノードが
シーン階層のどこに位置しているかを確認 
できます。

ノード名 - どのノードが現在選択され、これらの
アトリビュート値を生成しているかを示します。

Attribute Class ボタン - これらのボタンを使用する
と、表示する属性の種類をフィルタリングできます。

ポイント番号 - ジオメトリのポイント番号は、モデル
上でのアトリビュートの位置を特定しやすくします。

アトリビュート値 - ノードネットワークチェーンの
このポイントでの値です。

フィルタ - 多くのパラメータを使用している場合
は、ここにパラメータ名を入力すると、リストを
フィルタリングできます。
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ジオメトリの選択
Houdini での作業では、さまざまな要素を選択して操作する必要があります。ポイント、エッジ、プリミティブなどの
オブジェクトやジオメトリコンポーネントを効率的に扱うためのツールやオプションが多数用意されています。

  Select ツール
Select ツールを使用すると、選択に集中でき、操作ハンドルは表示さ
れません。 

	�  Select ツール	 S

Move や Rotate ツールを使用する場合や、Secure Selection が
オンのときは、Select ツールを呼び出して選択する必要があります。
Secure Selection をオフに切り替えると、自由に選択できるようにな
ります。

	� 他のツールの使用中に Select ツールを呼び出す	  S を押したままにする 
	�  Secure Selection の切り替え 	 ~

選択タイプ
追加選択、選択解除、選択 / 選択解除の切り替え、すべて選択、なに
も選択しないなど、さまざまホットキーがあります。これらのテクニッ
クは、Houdini ワークフローで重要な役割を果たします。

	� 選択 	 LMB
	� 追加選択	 Shift + LMB
	� 選択解除	 Ctrl（Cmd）+ LMB
	� 選択 / 選択解除の切り替え	 Ctrl（Cmd）+ Shift + LMB
	� すべて選択	 A（オブジェクトレベル）/ N（ジオメトリレベル）
	� なにも選択しない	 N（オブジェクトレベル）/ Shift + N（ジオメトリレベル）

選択テクニック
ビューポートでは、4 種類の選択タイプのいずれかでジオメトリにアク
セスできます。

	�  Box Selection	 F2
	�  Lasso Selection 	 F3
	�  Brush Selection	 F4
	�  Laser Selection	 F5

選択フィルタを使用して、可視のジオメトリにフォーカスしたり、グルー
プを選択したりすることもできます。選択を容易にするオプションが、
多数用意されています。

	�  Select Visible Geometry Only	 Shift + V
	�  Select Fully Contained Geometry Only	 Shift + C
	�  Select Groups または Connected Geometry	 9
	�  Select Whole Geometry	 オペレーションコントロールツールバーで選択
	�  Select by Normals	 オペレーションコントロールツールバーで選択

選択モード
選択モードを使用すると、オブジェクトやコンポーネントを選択できるよ
うになります。ツールバーのボタンやホットキーを使用すれば、オブジェ
クトレベルからジオメトリレベルに簡単にジャンプすることも可能です。 
オブジェクト - オブジェクトネットワークレベルは、オブジェクトのトランス
フォームを操作する場所です。View ツール以外のツールでは、次のホット
キーでオブジェクトレベルに戻ることができます。

	�  オブジェクト	 1
ジオメトリ - Viewツール以外では、次のいずれかのホットキーを使用すると、
選択したコンポーネントが選択可能な状態になっているジオメトリレベルに
ジャンプすることができます。

	�  ポイント 	 2
	�  エッジ	 3
	�  プリミティブ（フェース）	 4
	�  頂点 	 5

 TWEAK モード
同時にアクティブにできるジオメトリ選択モードは、1 つだけです。
Edit ノードで作業している場合は、Tweak モードでポイント、エッジ、
プリミティブの組み合わせを選択することができます。 

選択モードのメニュー
各選択モードには、シーンにどのように 
作用するかを変更できるオプションが用意
されています。これらのオプションにアクセ
スするには、各モードのアイコンを LMB  
クリックまたは RMB クリックします。

コンポーネントを扱う場合、このメニュー
では Show Display Operator または 
Show Current Operator を選択できま
す。Edit ノードを使用しているとき、これら
のオプションは Scene View の上部でも 
利用可能です。 

オブジェクトレベルでは、このメニューは 
異なります。オブジェクトの種類に応じた
フィルタや、マテリアル、拘束、デジタル 
アセットをより簡単に選択するためのオプ
ションが含まれています。

エッジループ - エッジループを選択するには、エッジを
選択した状態でダブルクリックします。不完全なループ
を選択するには、一方の端を選択して A を押してから、
もう一方の端のエッジを選択します。これは、ポイント
やプリミティブでも機能します。同じテクニックを使用
して、ポイントループやプリミティブループも選択する
ことができます。 

選択タイプ - 上部のバーにあるこのオプションを使
用して、選択のタイプを変更できます。Box、Lasso、
Brush、Laser のいずれかを選択できます。フィルタオ
プションもいくつかあります。

編集 | コンポーネント - これらのボタンから、どのコン
ポーネントを作業するかを選択します。ここではエッジ
選択がオンになっています。

Secure Selection - 他のツールを使用する間、現在の
選択をロックします。これがオンの状態で Select ツー
ルを呼び出すには、ホットキー S を押したままにします。

Select ツール - Select ツールを使用して選択すること
ができます。ホットキーの S を押してアクセスできます。

選択オプション
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選択コンポーネントのツールでの扱い
ビューポートでポイント、プリミティブ、またはエッジを選択してから
ツールを使用すると、ノードが作成され、選択がノードの Group パラ
メータにリストされます。 

例えば、ここではプリミティブ 5、6、9、10 が polyextrude  ノードで
使用されていることが分かります。Group ノードにリストされ、フェー
スを押し出すのに使用されているのを確認できます。

 

入力ジオメトリノードのトポロジを変更した場合、フェースの数が増減
したり、押し出しの場所が移動することがあります。このような場合は、
必要に応じてフェースを再選択します。

これを行うには、polyextrude  を選択し、Enter を押して Handle 
ツールに移動してから、̀  を押して再選択モードに切り替えます。 
新しいプリミティブを選択してから Enter を押すと、新しい選択が 
Group パラメータで使用されます。

すべて選択と Group フィールド
入力ジオメトリのすべてのプリミティブを選択するには、Group パラ
メータを空のままにします。入力ジオメトリのトポロジが変更された
場合も、ノードがすべて処理してくれます。 
ビューポートですべて選択（N）を使用すると、ツールの使用時、通常こ
のフィールドは空のままになります。一部のツールでは、Group フィー
ルドに選択したすべてのパーツが表示されるので、手動でフィールドを
クリアして空にしなければなりません。

Group ノード
Group ノードを使用すると、ポイント、頂点、ポリゴン、エッジの選択
を名前で定義し、参照することができます。グループの定義は、ビュー
アでコンポーネントを選択するか、範囲やエクスプレッションを使って
数学的に行います。その後、ポイント番号やプリミティブ番号を使う 
代わりに、Group パラメータにグループ名を割り当てます。

 

使用可能な Group ノードをいくつか紹介します。
	� Group Create - インタラクティブな選択、境界ボックス、フェースの 

法線の向き、エッジの角度を使用して、グループを作成します。
	� Group by Range - 範囲とシンプルなパターンを選択して、グループを 

作成します。 
	� Group Expression - VEX エクスプレッションを使用して、グループメン

バーシップを定義します。
	� Group Paint - インタラクティブなペイントインターフェースを使用して、

グループ化するジオメトリを選択します。

シェーディングオプション - Scene View に
何を表示するかを決定します。ここでは 
Smooth Wire Shaded が選択されています。

RMB メニュー - Select ツールの使用時、 
このメニューでは選択の反転、境界の選択、
選択の拡大と縮小などの選択オプションに 
アクセスできます。

ディスプレイフィルタ - ボーン、Null オブ
ジェクト、ライト、カメラなど、必要ないも
のを非表示にして、作業に集中できるよう
にすることができます。

Display Options - 選択モードは、選択し
やすいようにエッジやポイントを示してくれ
ますが、他のツールの使用時、それらは表
示されません。これらのオプションを使用す
ると、特定のモデリングツールを使用してい
ないときでも、さまざまな要素を表示した
ままにすることができます。 
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トランスフォームと編集
オブジェクトの基本のトランスフォームツールから、アニメーションリグの Pose ツール、ジオメトリを形状変更する 
Edit ノードまで、ビューポートでインタラクティブなハンドルを使用できる各種ツールが用意されています。 
Houdini では、これらのハンドルは、作業中のノードと密接に結びついています。 

トランスフォームツール
トランスフォームツールでは、ハンドルを使用してオブジェクトを操作し
たり、ジオメトリの形状を変更します。オブジェクトをトランスフォーム
すると、オブジェクトレベルのパラメータが更新され、変更内容が反映
されます。 

	�  Move	 T
	�  Rotate	 R
	�  Scale	 E
	�  Pose	 Ctrl + R
	�  Handle	 Enter

Handle ツールを使用すると、選択したノード特有のハンドルが表示さ
れます。これらのツールを使用している間は、S を押したままにするこ
とで再選択できます。新しく選択したら S を放して、トランスフォームを
続けます。

トランスフォームハンドル
Move ハンドルを使用すると、1 軸または 2 軸で移動したり、中心を 
使用してカメラ平面に沿って移動することができます。Rotate ハンド
ルと Scale ハンドルでも同様の操作が可能です。

1 軸

2 軸

カメラ平面
（3 軸）

 

MMB 移動
ハンドルを直接クリックしたくない場合は、空きスペースで中マウスボ
タンをクリックしながらドラッグすると、コンストラクション平面に沿っ
て移動できます。最も近い軸に沿って移動するように変更するには、
Edit > Preferences > Handles で Translate Handle を Map Drag 
to Axis に設定します。 

MMB 上下にドラッグ
Preferences が  
Map Drag to Axis に 
設定されている場合、 
Y 軸に沿って動く

  POSE ツール
アニメートするときは、Pose ツールを使用してボーンを操作したり、 
オブジェクトの動きを示すモーションパスハンドルを表示します。 
その後、接線ハンドルやキーフレームを使用して、ビューポートで動き
を変更します。 

モーションパス
ハンドル

IK ハンドル

編集 | コンポーネント - これらのボタンを 
使用して、編集したいコンポーネントを選択
します。ここでは Points オプションが選択さ
れています。

Move ツール - Move ツールでは、Scene 
View のハンドルを使用して選択を移動でき
ます。

Move ハンドル - 矢印を使用すると 1 軸で 
移動でき、正方形のドットを使用すると 2 軸
で移動することができます。ハンドルを RMB 
クリックすると、ハンドルオプションが表示さ
れます。

Soft Edit Radius - サーフェス上のポイント
を移動するとき、この半径値を使用して、 
ソフトな減衰を作成できます。プリミティブま
たはエッジでは、Soft Edit Radius は機能し
ません。

ジオメトリの編集
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  Edit ノード
ジオメトリコンポーネントを移動しようとすると、Edit ノードが配置さ
れ、トランスフォームを受け入れます。ジオメトリのトランスフォームだ
けでなく、サーフェス上を滑るようにしたり、法線に対して垂直にトラン
スフォームしたり、Sculpt を適用することも可能です。

	�  Edit	 T/R/E
	�  Slide on Surface	 L
	�  Peak	 H
	�  Sculpt	 B

ソフトな減衰
ポイントをトランスフォームするとき、Soft Edit Radius 使用すると減
衰を作成できます。ビジュアライザが呼び出され、サーフェス上のどこ
で減衰が発生しているかを確認できます。

Peak ハンドル

Soft Edit  
ビジュアライザ

Soft Edit HUD

EDIT オプション
Edit ノードを RMB クリックすると、選択をトランスフォームするための
オプションが表示されます。選択を円にしたり、まっすぐにすることが
できます。これらのオプションは、ポイントとエッジに対して機能します
が、プリミティブに対しては機能しない場合もあります。

	� Make Circle	 Shift + C
	� Evenly Space Selection	 Shift + E
	� Relax Selection	 Shift + R
	� Straighten Selection	 Shift + S

  Handle ツール
シェルフツールを使った後は、たいてい Handle ツールに切り替えら
れています。また、ネットワーク内のノードを選択し、Scene View で 
Enter キーを押しても、Handle ツールに切り替わります。これにより、
polyextrude ノードの distance  パラメータなど、選択したノード特有
のパラメータにフォーカスしたハンドルが表示されます。 
Show Current Operator - デフォルトでは、表示ノード以外のノードを選択
すると、それが現行ノードとなり、ジオメトリのワイヤーフレームが表示され
ます。その後、ハンドルを使用してこの中間ノードを操作しながら、シェーディ
ングサーフェス上で結果を評価できます。 

Show Display Operator - もう 1 つのオプションは、表示オペレータを常に
表示します。この場合、チェーン内のノードを選択してもワイヤーフレームは
表示されず、ハンドルは表示ノードにフォーカスしたままになります。

パラメータは現行ノードのパラメータエディタで変更できますが、 
ハンドルは表示ノードのパラメータで機能し続けます。 

ハンドルオプション
すべてのハンドルにメニューがあり、
任意の部分を RMB クリックすること
でアクセスできます。

このメニューには、ハンドルを整列し
たり、ノードのパラメータから切り離
したり、Pivot Mode に設定するなど
のオプションが用意されています。 
これらのオプションを使用して、ハン
ドルの動作をカスタマイズできます。

また、ハンドルのパラメータすべてを
キーフレームに設定したり、ハンドル
の全パーツをデジタルアセットにプロ
モートすることもできます。パラメー
タをプロモートすると、アセットレベ
ルでハンドルにアクセスできるように
なります。

シェーディングオプション - Scene View に何を表示す
るかを決定します。ここでは、Smooth Wire Shaded 
が選択されています。

Sloppy Selection - Edit ノードが Sloppy 選択を使用
している場合、3 つのコンポーネントボタンを同時に選
択することができます。これらすべてのボタンを使用し
たより流動的な選択プロセスが可能です。

RMB メニュー - フォーカスしたい編集のタイプなど、
Edit ツールオプションにアクセスできます。Scene View 
の上部のバーでもこの情報を利用可能です。

コンポーネントの選択 - このメニューを使用してコン
ポーネントタイプを選択できます。メインツールバーに
もこれと同じオプションがあります。

Edit オプション - Make Circle や Straighten 
selection などのオペレーションを使用して、 
コンポーネントを編集できます。
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モデリングツール
Houdini には、ジオメトリを作成、形成、変形して目的の外観にするツールが多数用意されています。 
ここでは、Houdini のジオメトリ（SOP）コンテキストでモデルを構築する際、よく使用する各種ツールのうち 
一部を取り上げます。

作成
ジオメトリの作成は、基本形状を使用するか、カーブを描画すること
から開始します。いずれの場合も、そのツール名のオブジェクトが作
成され、その内部にジオメトリ/ SOP ノードが含まれます。ツールには 
Create シェルフまたは Radial メニューからアクセスできます。

 プリミティブ - Houdini には、Box、Sphere、Tube、Torus プリミティブ 
形状と、さまざまなプラトン立体があります。

 Grid - Grid ツールは、多様なモデルの出発点として最適です。ジオメトリ
レベルで形状とサイズを設定できます。

 Curve - コントロールポイントを配置しながらカーブを描画し、その後 
Bezier、NURBS、またはポリゴンカーブを作成します。

ポリゴンモデリング
ポリゴンは、最も一般的なジオメトリタイプの 1 つで、中でもビデオ
ゲームプロジェクトでは必須です。Houdini には、モデルの開発に 
使用できる、包括的なポリモデリングツールセットが含まれています。

 PolyDraw - このツールを使用すると、コンストラクション平面で、または
既存のジオメトリにスナップすることで、インタラクティブにポリゴンメッシュ
を描画できます。

 PolyExtrude - 1 つまたは複数のポリゴンを押したり引いたりして、ジオ
メトリの形状を変更します。押し出しのプロファイルを制御して、さまざまな
形状を得られます。 

 PolyBevel - 選択したエッジにベベルをかけて、まっすぐな面取りや丸い
面取りを作成します。通常、Polyxtrude や Boolean などの前のノードの出力
グループを使用して、適切なエッジを自動的に見つけられます。

 PolyBridge - ブリッジの形状を制御しながら、2 組のポリゴンをつなげ
ます。

 PolySplit/Edge Loop/Knife - これらのツールを使用すると、ポリゴンを
分割してモデルにディテールを追加できます。

 PolyExpand 2D - 2D 平面上のカーブやエッジを取り込み、任意のオフ
セット値に基づいてジオメトリを作成します。

 PolyReduce - 四角形トポロジと UV を維持したままポリゴン数を減らす
ことで、異なるレベルのディテールを作成できます。

 PointWeld - ポイントのグループを他のターゲットポイントにインタラク
ティブにスナップさせ、それらを結合します。

ユーティリティノード
Houdini はプロシージャルなため、コピー、クリップ、ミラーなどの 
モデリングアクションを行うと、ネットワークにノードが作成されます。
この仕組みにより、後で戻って変更を加えるのも簡単にできます。 

 Clip - クリッピング平面を基準にモデルを切断します。クリップの方向を
設定したり、片側、もう片側、または両方を保持するかどうかを選択できます。

 Mirror - クリッピング平面を基準にジオメトリを反転します。ミラー後に
ポイントを結合するオプションがあります。

 Copy and Transform - トランスフォーム値に基づいて複数のコピーを
作成します。

 Blast - モデルからポリゴンを削除します。選択したポリゴンを削除するか
保持するかを選択できます。ポイントまたはポリゴンを選択している状態で 
Delete キーを押すと、それらを削除できます。

 Dissolve - 周囲のジオメトリを壊すことなく、エッジを削除できます。 
エッジを選択した状態で Delete キーを押すと、そのエッジを削除できます。

 サブディビジョンサーフェスモデリング
Houdini では、ポリゴンでモデリングした後、オブジェクトのパラメータ
エディタの Render タブにあるオプションを使用して、サブディビジョ
ンサーフェスとして表示したりレンダリングすることができます。また、
ジオメトリレベルで Subdivide ノードを作成し、ポリゴンを追加すれ
ば、よりディテールの多いトポロジで作業できます。

 

サーフェス化ツール
Houdini には、プロファイルカーブを受け取ってサーフェスを構築する
ツールがあります。入力カーブは、Bezier、ポリゴン、NURBS カーブの
いずれか、またはそれらの混合です。

 Revolve - 軸を基準にプロファイルカーブを回転させて、ジオメトリを作
成します。結果はハンドルを使って微調整できます。

 Skin - 複数のカーブを受け取り、それらをサーフェスに変換します。
 Rails - 1 つまたは複数のプロファイルカーブを 1 つまたは複数のレール

カーブに沿ってコピーしてから、結果をスキン化してサーフェスを取得します。
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  BOOLEAN
Boolean ツールを使用すると、ジオメトリの減算（Subtract）、 
結合（Union）、交差（Intersect）を計算できます。このノードは非常に
複雑なトポロジを扱うことができ、サーフェスを分解して、リジッドボ
ディダイナミクスを用いた破壊を作成することができます。多くの場合、
ボロノイベースの Shatter ノードよりもリアルな結果を得られます。 

Boolean ツールは出力グループを作成し、それを使って Polybevel 
ノードなどの他のノードに接続できます。こうすることで、Boolean に
対する更新は、2 つ目のノードに渡されたタイミングで適切に更新され
ます。 

変形ツール
ポイントを直接編集してジオメトリを形づくることもできますが、より 
汎用的なアプローチが必要な場合もあります。次のノードは、ジオメト
リをプロシージャルに形成するためのオプションを備えています。

 Bend - キャプチャ範囲と方向を設定して、含まれるジオメトリに対して 
曲げ、捻じり、テーパ、収縮などを適用します。

 Lattice - ジオメトリの周りにラティスを構築し、ケージ上のポイントを 
編集してジオメトリの形状を変更できるようにします。カスタムのケージも 
使用可能です。

 Mountain - ノイズ関数を適用してサーフェスを変形し、ランダムな結果
を作成します。このノードでは、ポイントが実際に動かされます。

 Ripple - ジオメトリに波紋の形状を作成します。
 Waves - ノイズ関数を追加して、時間の経過に応じてアニメートされる、

波のようなパターンを作成します。リアルな海を作成するのに最適です。

  COPY TO POINTS + SCATTER AND ALIGN
一般な Houdini ワークフローでは、サーフェス上にポイントをばら撒
いて整列させてから（Scatter and Align）、ポイントにコピー（Copy 
to Points）します。その後、オブジェクトをスケールしたり回転するた
めのアトリビュートを適用すると、有機的な結果が得られます。これは、
木や岩を含む風景を作成する際によく使用される方法です。 

  TOPOBUILD
Houdini の TopoBuild ノードを使用すると、Pixologic の ZBrush よう
なアプリケーションでスキャンしたり作成した高解像度のジオメトリに 
直接ポリゴンを描画できます。アニメーション用のクリーンなトポロジを
作成してから、元のモデルのディテールを法線マップにベイクできます。 

  ボリューム
ボリュームには、空間内のボクセル（3 次元ピクセル）の値を格納でき
ます。ダイナミクスツールを使用する際の衝突をサポートしたり、雲を
作成するためによく使われます。また、モデリングでは、複数の形状を 
1 つのボリュームにまとめ、それを変換してサーフェスに戻すことも可
能です。

 

ジオメトリタイプ
Houdini は、プリミティブ、ポリゴン、NURBS、Bezier など、さまざまなジオメトリタ
イプをサポートしています。こうしたタイプ間の変換が可能であり、1 つのオブジェクト
内で複数のジオメトリタイプを結合することもできます。 
ポリゴンモデルは、Pixar の OpenSubdiv 標準を使用して、サブディビジョンサー
フェスとして表示およびレンダリングするようセットアップすることができます。サブディ
ビジョンと NURBS は両方とも、テッセレーション設定に依存することなく、Karma と 
Mantra で非常に滑らかにレンダリングされます。
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UV とテクスチャ
2D マップを 3D オブジェクトに適切にフィットさせるには、ジオメトリの平坦化したビューを定義する UV 座標が必要
です。Houdini で最初にジオメトリを作成したときには、UV はありません。プリミティブオブジェクトにも、組み込み
の UV はありません。これは、1 つまたは複数の SOP ノードを使用して、ジオメトリレベルで UV を追加する必要が
あることを意味します。

UV テクスチャの表示
Houdini のジオメトリには、デフォルトでは UV テクスチャアトリ
ビュートがセットアップされていないため、UV ツールを使用して
追加する必要があります。UV をセットアップすると、Display Options 
バーの Show UV Texture がオンになり、ジオメトリにテクスチャグリッ
ドが表示されます。UV テクスチャを表示したくない場合や、カラーテク
スチャに変更したい場合は、オフにします。 

UV PROJECT
このノードでは、いくつかある投影テクニックの 1 つを使用して、UV 
を割り当てます。投影タイプを選択したら、オブジェクトに合わせて
投影を初期化します。これにより、UV が反転される場合があるため、
Rotate X の値を 90 ではなく -90 に設定する必要があります。上の図は 
Orthographic（正投影）、下の図は Toroidal（ドーナツ状）投影です。 

UV FLATTEN
UV Flatten は、選択したエッジまたはエッジグループで事前定義した
境界を基に、ジオメトリをアンラップ（展開）します。UV ビューでポイン
トをピン留めしたり、希望するルックになるよう島を調整して、結果を
微調整できます。 

threedscans.com より、彫刻のスキャン

UV Edit と UV Distortion
個々の頂点や頂点グループを編集するには、UV Edit または UV 
Transform ノードのいずれかを使用します。UV Edit ノードは 1 つの 
ノードで大量の編集を行えますが、UV Transform は 1 つのノードで行え
る編集は 1 つです。そのため、よりプロシージャルな結果を得られます。
UV ビューポートメニューで Display > UV Distortion を選択すると、 
どの程度多くの編集を加えたかを確認できます。

UV LAYOUT
UV Layout は、UV 島を作成し、可能な限り効率的に UV 空間内に 
詰め込みます。ジオメトリ上で利用されるテクスチャ量が最大化され、
レンダリングとゲームプレイの両方を最適化できます。

領域ハンドルを使用して、UV レイアウトを UV 空間の特定の部分に 
配置できます。後続のレイアウトがこのレイアウトを避けるようにする
には、Pack Island in Cavities of Other Islands オプションを使用
します。 

UDIM
使用できるのは単一の UV タイルだけではありません。UDIM を使用 
すると、UV を多数のタイル上に拡張できます。このテクニックでは、
UV 島が密接に詰め込まれないため、ディテールの豊富なテクスチャ
マップを作成できます。テクスチャマップに適切に番号が付けられ、 
適切なタイルに割り当てられます。
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UV アトリビュート
前の項では、ジオメトリにアトリビュートを割り当てて、重要な情報を
ネットワークに伝えられるのだと学びました。UV は、テクスチャマップ
をモデルにラップできる頂点アトリビュートで、同じようにネットワーク
に伝達されます。 
これらのアトリビュートは UV ビューポートで視覚化され、Geometry 
Spreadsheet で分析されます。このようなアトリビュートは、上級 TD 
がスクリプトを使用して UV を管理するための Attribute Wrangle ノー
ドをはじめ、さまざまなな SOP ノードで使用できます。

UV セット
同一ジオメトリに複数の UV セットを作成できます。UV ノードを使用する
ときに、UV アトリビュートを設定します。デフォルトでこれは uv ですが、
uv2 を作成して、2 つ目のセットを作成することも可能です。異なる UV 
セットは、VOP でテクスチャを割り当てるときに使用します。これにより、
テクスチャマップごとに異なる UV アトリビュートを使用できます。

上の 2 つの画像では、1 つ目は Toroidal（ドーナツ状）投影で uv  UV ア
トリビュートに割り当てられていますが、2 つ目は Orthographic（正投
影）でuv2  UV アトリビュートに割り当てられています。これらの UV ア
トリビュートには任意の名前を付けることができ、例えば uv2  ではな
く bob  としてもかまいません。

UV ビューポートメニュー
UV ビューポートメニューを使用すると、UV アトリビュートに基づいて 
UV を表示できます。また、このメニューでは背景画像を確認すること
もできます。背景画像は、デフォルトの UV グリッドか、割り当てられた
マテリアルから引き出されたテクスチャマップです。 

このメニューには、UV Overlap、UV Backfaces、UV Distortion と
いったディスプレイオプションもあります。これらのオプションは、UV 
を評価して、さらに微調整が必要かどうかを判断するのに役立ちます。

ATTRIBUTE TRANSFER
アトリビュートの管理に使用できる SOP ノードの 1 つである Attribute 
Transfer を使用すると、あるジオメトリの UV アトリビュートを、
Proximitity（近接度）に基づいて別のジオメトリに転送することができ
ます。 
これは、モデルのトポロジを変更したが、元のモデル用に UV を作成し
た際の作業内容を保持したい場合に便利です。

現行ツール - Scene View の 
上部には、Handle ツールが 
アクティブであれば、選択した
ノードが表示されます。

背景 - メインタイルの背景は、 
UV メニューのオプションを使用
して設定できます。

メインタイルの外側 - 複数の 
タイルをカバーする UDIM を使用
しない限り、テクスチャが繰り返
されるため、メインタイルの外側
の領域に配置されたポリゴンは
メインタイル上の同じ領域とオー
バーラップします。

SCENE VIEW | UV

UV メニュー - UV ビューにいると
き、このメニューには UV に 
関連したさまざまなオプションが
表示されます。

ビューメニュー - このメニューでは、
このビューポートに表示するの UV 
ビューを選択できます。

レイアウトハンドル - このハンドル
は、UV Layout ノードの一部です。
タイルの特定の部分の UV に集中
できます。

既存データを基準とした詰め込み 
- UV が既に設定されている既存の
ジオメトリの周囲に、UV を詰め込
みます。 
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ルックデブ : シェーダとマテリアル
シーン内のオブジェクトをレンダリングするには、シェーダとも呼ばれるマテリアルをジオメトリに割り当てる必要が
あります。Houdini では、これらのマテリアルやシェーダは Material/Vex Builder ネットワークで作成されます。 
ノードを使用してマテリアルを構築する機能は、ショットのルックを定義する際の強力なツールとなります。

Houdini では、さまざまなタイプのノードをいくつかのネットワーク 
タイプに分けていますが、マテリアルの場合は /mat ネットワークタイ
プを使用します。ここでは、Karma と Mantra 向けの VEX オペレー
タや、Karma 向けの Material X をセットアップすることができます。
MaterialX は、Lucasfilm® が開発したオープン規格で、アプリケーショ
ンとレンダラ間でルックデベロップメントコンテンツを転送するために
使用されます。 

MATERIAL PALETTE
Material Palette を使用して VEX ベースのマテリアルを追加し、 
クリックアンドドラッグでオブジェクトに割り当てることができます。 
このペインには、シーン内のマテリアルを管理するワークスペースが 
あり、Material Library LOP など、サブネットワークを表すタブに分
かれています。Tab キーを使用して、MaterialX シェーダをマテリアル
ネットワークに追加できます。配置すると、Material Palette に表示さ
れるようになります。

LOP でのマテリアルの割り当て
Solaris LOP コンテキストでマテリアルを割り当てるには、まず /mat  
ネットワークを含む Material Library LOP を作成します。このノード
を使用するか、下流で Assign Material LOP を使用して、マテリアル
を割り当てられます。Material Palette では、ギャラリーからライブラ
リにマテリアルをドラッグできます。LOP では、矢印ボタンを使ってシー
ングラフのマテリアルリストにアクセスできます。

Principled Shader
Material Palette には、Brent Burley 氏による Disney "principled" 
BRDF（Disney 原則 BRDF）をベースとしたマテリアル、Principled 
Shader が含まれています。このシェーダは、アーティストが扱いやす
いように、物理的ではなく「原則に基づいた」ものになっています。
Principled Shader は、Base Color、Bump、Normal、
Displacement などのパラメータに直接テクスチャを割り当てられるよ
うになっています。割り当てたテクスチャマップはビューポートに表示
され、簡単にさまざまなルックを実現することができます。 
このマテリアルは他の VOP に接続することで拡張可能ですが、それが
必須なわけではありません。ギャラリーに含まれるマテリアルの多く
は、このシェーダのバリエーションです。

PRINCIPLED SHADER CORE
Principled Shader Core ノードは、Principled Shader 内にあり、
シェーディングモデルの主な機能を含んでいます。ただし、すべての 
テクスチャリング機能を搭載しているわけではありません。 
このノードを使用してゼロから堅牢なシェーダを構築するには、
Houdini のシェーダ構築ツールを使用して VOP ノードを追加する 
必要があります。このためには、ノードビューでノードを接続したり、
Shader FX メニューを使用してノードを追加したりします。

MATERIAL PALETTE

ギャラリー内のマテリアル -  
ここにリストされるマテリアルは、
ディスク上のギャラリーファイル
に保存されています。右側のシー
ン領域か、ビューポートのオブ
ジェクトにドラッグできます。
シーン内のマテリアル - ここには
シーンファイルの一部であるマテ
リアルが表示されます。ここから
ビューポートにドラッグすること
で、オブジェクトに割り当てること
ができます。
Material Library LOP -  
LOP コンテキストでセットアップ
されたマテリアルは、Material 
Library に配置できます。ギャラ
リーからここにマテリアルをドラッ
グすることができます。

Update Material アイコン - 
すべてのマテリアルアイコンを
更新するには、このボタンを 
クリックします。1 つずつ更新
するには、マテリアルを RMB 
クリックします。

マテリアルの割り当て - シーン
内のオブジェクトとパレット内 
のマテリアルを選択すると、 
このボタンを使用してマテリア
ルを割り当てることができます。

ダブルクリックして編集 -  
いずれかのマテリアルをダブル
クリックすると、ノードビューに
ジャンプして、/mat レベルで
編集できるようになります。
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マテリアルのレイヤー化
オブジェクトをユニークなルックにするために、マテリアルをレイヤー
化することができます。Layer Mix ノードを使用して 2 つの異なるマテ
リアルを組み合わせ、1 つのルックを作成します。例えば、このテクニッ
クを使って光沢のある金属マテリアルとマットな錆マテリアルをレイ
ヤー化することが可能です。そうしておいてから、アルファチャンネルを
テクスチャ化し、サーフェスあるいはディスプレイスメント、またはその
両方を組み合わせたマテリアルを設定します。

MATERIAL BUILDER
レイヤー化したノードを新しいマテリアルに変換したい場合は、ノード
を選択して、Edit > Collapse Selected into Material を選択します。
これにより、ノードが Material Builder 内に配置され、引き続き微調
整を行えます。このレベルでは、output  と collect  ノードがあり、ネッ
トワークを効率的に動作させることができます。

デジタルアセットとしてのマテリアル
マテリアルを Houdini デジタルアセットとして保存することで、マテリ
アルをさらに効率化できます。Asset Properties ペインで、Save タ
ブに移動して Save Cached Code を選択すると、Mantra でレンダリ
ングするときにマテリアルが事前にコンパイルされます。また、テクス
チャマップをデジタルアセットに読み込んで、アセットファイル内からそ
れらを参照することも可能です。マテリアルを HDA に変換することで、
チームとの共有が容易になります。

SHADER FX メニュー
マテリアル VOP を使用するときは、ネットワークビューでノードを追加
して接続するか、各パラメータの右端にあるアイコンをクリックすると
表示される Shader FX メニューを使用します。このメニューを使用す
ると、作業したいパラメータにフォーカスして、コンテキストでノードを
作成できます。

パラメータエディタで、右端のアイコンから各パラメータの接続タイプ
を確認できます。

	� 接続なし	  
	� Parameter ノード	  
	� 他のノードと接続	  
	� 非表示の接続	  

プロシージャルなマテリアルの割り当て
多くのデータを扱うプロダクションでは、多くの場合、プロシージャル
なアプローチでマテリアルを割り当てる必要があります。Solaris や 
Karma でこれを実現するには、Assign Material LOP や Material 
Variation LOP などのノードを使用します。 
Mantra を使用している場合、Data Tree パネルを使用してマテリア
ルをオブジェクトに割り当てることができ、このペインから Material 
Stylesheets にアクセスできます。スタイルシートでは、ルールを使用
して大規模なオブジェクトグループにマテリアルやテクスチャを割り当
てられます。 

シェーダ構築

ノードパス - 現在のパスを確認でき、
マテリアルネットワーク内を移動しや
すくなります。

VOP ノード - マテリアルコンテキスト
では、マテリアルノードから開始し、
VOP ノードを接続して、マテリアルの
テクスチャリングをカスタマイズしま
す。完了したら、すべてを折り畳んで 
Material Builder ノードに戻すこと
ができます。

ノードコネクタ - ドットを MMB ク
リックしてアクセスする Shader FX 
メニューを使用して、この領域にノー
ドを追加できます。ドットを RMB ク
リックすると、完全なノードメニュー
が表示されます。

Principled Material - 単体で割
り当てたり、Layer Mix に接続で
きる代表的なマテリアルです。

Layer Mix - マテリアルでのレイ
ヤー出力は、このミックスノードに
送ることができます。これをジオメ
トリに割り当てられます。

Material フラグ - レイヤーのミッ
クスを Material Palette に表示さ
せたい場合は、このフラグをオン
にします。

アルファ - ここでは、VOP ノード
が Layer Mix ノードのアルファを
送り、2 つのレイヤーマテリアルの
アルファマスクを作成しています。
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Solaris : レイアウト
Solaris は、ルックデブ、レイアウト、ライティングに特化した Houdini のコンテキストで、USD が中核にあります。
このコンテキストに取り込まれたオブジェクトやジオメトリは USD となり、専用のノードを使用してオブジェクトの 
配置、ジオメトリのインスタンス化、ショットレイアウトの管理などを行えます。

SOLARIS : LOP
Solaris 環境を使用するには、/stage ネットワークに移動するか、
LOP ネットワークを作成します。ここに、ジオメトリの取り込み、マテリ
アルの割り当て、ライトやカメラの追加を行うためのノードが配置され
ます。これらのノードでは、共有アセットを使用してシーケンスやショッ
トを作成したり、プロシージャルな編集ノードで各ショットの設定を 
カスタマイズすることができます。

その中核において、Solaris 環境はすべてを USD（Universal Scene 
Description）に変換します。USD は、PIXAR によって作成されたオー
プンソースイニシアティブです。Solaris/LOP コンテキストでは、プロ
シージャルノードで USD をネイティブに使用し、参照、ペイロード、 
レイヤー、コレクション、バリアント、詳細レベルといった USD の概念
を管理できます。

LOP ネットワークは、Karma または他の Hydra 互換レンダラを使用し
てレンダリングできます。Hydra は、USD をビューポートにレンダリン
グしてインタラクティブに探求したり、最終レンダリングとしてディスク
上にレンダリングするためのテクノロジです。

SCENE IMPORT : オブジェクトを LOP に
Houdini のオブジェクトレベルでレイアウトやライティングを扱うことに
慣れたアーティストは、Scene Import LOP ノードを使用すると、ジ
オメトリ、ライト、カメラを簡単に LOP に取り込んでレンダリングでき
ます。制御された USD シーングラフを作成したい場に合は、別のアプ
ローチをお勧めしますが、Karma や他のレンダラに素早くアクセスす
るには Scene Import ノードが役立ちます。

USD 用にアセットを準備
Component Builder LOP ネットワークまたは USD Export SOP を
使用して、プロップを構成する方法もあります。ジオメトリとマテリア
ルをプロップごとにセットアップしてから、レイアウト段階で使用できる
ように USD として書き出します。 

 

プロップの一部には、バリアントを使用して、レイアウト時に選択する
バリエーションを複数作成します。この USD の概念をセットアップでき
る LOP ノードがあります。
USD としてプロップをセットアップしたら、そのファイルを Sublayer 
や Reference LOP を使用してより大きいレイアウトシーンファイルに
取り込み、Edit LOP を使ってプロップを配置します。アセットが適切
に準備されていれば、ジオメトリ、マテリアル、バリアントがセットアッ
プされ、準備が整った状態のアセットを使用できるようになります。

SOLARIS デスクトップ
ステージ - ステージビューは、
レイアウトやライティングを確
認したり、プリミティブ、ライト、
カメラをインタラクティブに操
作して適切にセットアップする
ための場所です。
ビューポートレンダー -  
ステージでは、Houdini GL ま
たは Storm を使用して、USD 
GL ソリューションをレンダリン
グできます。また、Karma や 
Hydra 準拠のサードパーティ製
レンダラにインタラクティブにレ
ンダリングすることも可能です。
シーングラフ - USD 構造は、 
レンダリング可能なシーングラ
フを提供し、このパネルを使用
してグラフを検査できます。

Stage Manager - この 
ノードは、USD ファイルを 
読み込んで、ステージ上に
配置することができます。

LOP ノード - LOP のすべて
のアクションは、プロシー
ジャルノードを使って実現 
されるため、簡単に戻って
変更を加えられます。

Scene Graph Details - 
シーングラフでアイテムを 
選択すると、詳細を確認し、
パイプラインでのステータス
を把握できます。
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STAGE MANAGER
Stage Manager は、ディスク上の USD アセットを参照したり、それら
を 3D 空間でトランスフォームしたり、シーン階層を調整するためのワ
ンストップノードとして設計されています。これには、入力レイヤーを
平坦化し、上流からの変更をブロックすることも含まれます。この柔軟
性の欠如は、迅速なセットアップが可能という利点によってバランスさ
れています。

物理ベースの編集 
すべてのプロップをステージに読み込んだら、Edit LOP を使用してプ
ロップを移動することができます。編集は別の非破壊レイヤーとなり、
参照されたアセットは元のまま残るので、後で戻る必要がある場合も
安心です。

Edit LOP の Use Physics オプションをオンにすると、Houdini のリ
ジッドボディの機能を利用して衝突を検出したり、オブジェクトをリア
ルに配置できるようになります。3D ビューでインタラクティブに作業し
ながら、自然で有機的なルックを実現できます。

インスタンス化
USD には、LOP で利用できるインスタンス化ソリューションがあります。
Instance LOP では、1 つまたは複数のオブジェクトを入力して、LOP 
内でセットアップしたポイントに分散させることができます。これらの
ポイントは、シーンからジオメトリをインポートし、モデルから抽出した
サーフェスにポイントをばら撒くことで作成されます。
マテリアルは、さまざまな方法でインスタンスに割り当てることができ
ます。その方法の 1 つである Material Variation LOP では、ジオメト
リごとにレンダリングプロパティを設定することも可能です。

また、Layout Asset Browser と Layout LOP を使用すると、ブラウ
ザで選択したアセットを参照するインスタンスポイントをブラシワーク
フローで配置、編集、トランスフォームすることができます。

USD への書き出し
LOP グラフのさまざまなポイントで、ノードを RMB クリックして LOP 
Actions > Inspect Active Layer を選択することで、USD コードを
検査できます。また、平坦化したステージを検査することも可能です。
USD に書き出すときは、すべてのレイヤーを分解することも、平坦化
した単一のグラフとして保存することもできます。

シーングラフ
Stage - LOP を作成するため
のトップレベルのネットワーク
コンテキストです。 
また、この作業のすべてを 
LOP ネットワークで行えます。
Scene Graph Path - これら
は、ステージのルックを定義す
る USD レイヤーおよびサブレ
イヤーを表します。ほとんどの
場合、ディスク上のさまざまな 
USD ファイルがショットから 
参照されています。
Primitive Type - それぞれの
プリミティブに、タイプ、つまり
挙動を定義するスキーマがあ
ります。これは、各レイヤーの
ステージに対する寄与を特定
するのに役立ちます。

Draw Mode - パス内の任
意の要素の表示を、Full 
Geometry、Bounding Box、
Textured Cards のいずれかに
変更できます。
ディスプレイオプション -  
各レイヤーの可視性やアク
ティベーションを設定できま
す。シーングラフから何かを 
削除することはできないため、
非表示にしたり非アクティブに
する必要があります。 
Variants - レイヤーにバリア
ントがある場合は、選択され
ているものがここに表示され
ます。
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Solaris : カメラとライト
ショットをレンダリングする前に、カメラ越しにシーンを見て、シーンを照明する必要があります。Solaris/LOP  
コンテキストは、レイアウト、ルックデブ、ライティング、Karma によるレンダリング、オブジェクトレベルでは  
Mantra によるレンダリング向けに設計されており、ライトとカメラをセットアップできます。

  カメラ
カメラは、LOP Lights and Cameras シェルフからアクセスができま
す。シェルフツールで Alt クリックすると、現在のビューがカメラビュー
に変わります。ネットワークビューで Camera ノードを作成した場合
は、ビューポートの左上にある No cam メニューをクリックすると、 
カメラ越しに見られるようになります。 

カメラを調整するには、別のビューから、またはカメラ越しに見ながら、
カメラハンドルを使用して操作します。Display Options バーには  

 lock camera to view ボタンがあり、View ツールを使ってカメラ
の位置を変更できます。

 このオプションはオンのままにしないでください。オンのままにする
と、ビューを変更しただけでカメラビューが変わってしまうことになり
ます。気に入ったカメラビューは、トランスフォーム値をロックして、
ビューを変更しても失われないようにすることをお勧めします。

カメラプロパティ
LOP コンテキストのカメラには、カメラの画像生成方法を決める主な
プロパティがあります。 
View タブ

	� Projection - 遠近法または正投影のどちらにするかを選択します。
	� Focal Length - 焦点距離を選びます。値が小さいほどワイドなショット

（広角）に、値が大きいほどロングショット（望遠）になります。
	� Horizontal/Vertical Aperture - 絞りは、カメラに入る光の量を制御す

るゲートです。

Sampling タブ
	� Shutter Open/Close - シャッターを開いておく時間を決定します。 

この設定は、モーションブラーに影響します。
	� Focus Distance - カメラから焦点平面までの距離。Depth of Field を 

使用している場合には、どのオブジェクトを鮮明に見せる（焦点にする） 
かを決定します。

	� F-Stop - レンズの絞り。デフォルトは 0 で、焦点の範囲を無効にしてい
ます。

Shift + F を押すと、焦点平面が表示され、どのようにジオメトリと交
差しているかが分かります。カメラ越しに見ているときに、サーフェス
を Shift クリックまたはドラッグすると、そのポイントと交差するように
焦点平面を動かせます。カメラ視点外のときは、焦点平面上のハンド
ルを使用してその平面を動かし、被写界深度を設定します。

焦点平面の表示 
 （Shift + F）

サーフェス上を  
Shift クリック

ライティングセットアップ

ビューポートレンダリング -  
ライティングを決定するには、
Karma または RenderMan や 
Arnold などのレンダラを使用し
てビューポートでレンダリング
できることが重要です。 
HoudiniGL も使用できますが、
これらのメインレンダラほど効
果的ではありません。

ライトハンドル - カメラと同じ 
ように、一歩下がってビュー内
のライトを操作します。専用の
コントロールを使用して、カメ
ラビューでライトを設定するこ
とも可能です。

Primitive Path - USD シーン
グラフ内のライトの場所を設定
します。

ライトタイプ - このメニューで
は、ライトタイプを選択します。
Light LOP では、すべての 
ライトタイプにアクセスでき、
切り替えもできます。

ライトパラメータ - 円錐角や 
強度など、ライトのプロパティ
を制御するパラメータが幅広く
用意されています。

Light LOP ノード - ライトは
個々に、LOP ノードとしてネッ
トワークに追加されます。
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  ライト
ライトにはシェルフからもアクセスでき、同様のハンドルを使って配置
できます。Houdini には、さまざまなライトタイプが用意されています。

 Point Light - ポイントから全方向にライトを放出します。電球にも似た、
いわゆる点光源です。 

 Spot Light - 円錐形のライトのビームを、ポイントから特定の方向に放射
します。

 Area Light - 指定した領域上に、たくさんの光源を自動的に分散します。
Line、Tube、Grid、Disk、Sphere の 5 つの形状のエリアライトから選択でき
ます。

 Geometry Light - ジオメトリオブジェクトのサーフェスシェーダを使用し
て色を付けたライトを、シーンに放出します。

 Distant Light - 平行光線を放射します。このライトは、太陽光線に似て
います。

 Environment Light - 半球または球の環境からのライトをシーンに投影
します。 

カメラビューでのライティング 
Light または Light Mixer LOP を選択および表示している場合、カメ
ラ越しに見ながら、ライトのプロパティの多くを設定することができま
す。Specular（Shift + S）、Diffuse（Shift + D）、Shadow（Shift + F）
オプションを使用すると、シーン内のサーフェスをクリックしてライトを
セットアップできます。 

LMB クリックして 
ピボットを配置

Shadow モード 
（Shift + F）

Shift + LMB クリック 
してターゲットを配置

その後、Ctrl ドラッグして、ショットからライトの距離を変更したり、
Ctrl + Shift ドラッグして明るさを変更することができます。ビューポー
トでこうした操作を行うと、ハンドルをドラッグするために離れる必要
がないため、作業中のショットに集中できます。

LIGHT LINKER
ライトを特定のオブジェクトにリンクするのは、ショットのライティング
を制御するのに最適な方法です。Solaris では、Light Linker LOP を
使用してリンクできます。このノードには、オブジェクトとライトを接続
するためのインターフェースが含まれています。

ライトコレクションを使用すると、プリミティブとライト間の相互作用を
定義したルールを用いて、より効率的にリンクを適用できます。 

ライトのインスタンス化
Solaris/LOP コンテキストでは、Houdini のプロシージャルなジオメト
リノードを使用してポイントを作成し、それらのポイントにライトをイン
スタンス化できます。その後、ポイントにアトリビュートを追加して、例
えば、輝度を順に変化させて、レトロなマーキー看板のようなエフェク
トを作成することができます。このアプローチなら、ライトをセットアッ
プしやすいうえ、エフェクトを追加したり、ショットのニーズに合わせて
変更することも非常に簡単です。

LIGHT MIXER
ライトリスト - このリストには、ミキ
サーに接続しているすべてのライトが
表示されます。
コレクション - ライトをコレクション
にまとめると、ミキサー内でグループ
として機能させることができます。
ソロ - 星アイコンをクリックすると、
ライトまたはコレクションをソロにす
ることができます。
強度スライダ - 1 つ目のスライダで、
ライトまたはライトコレクションの強
度を制御できます。
露出スライダ - 2 つ目のスライダは、
露出を制御します。強度の微調整に
利用できます。
ライトカラー - ここをクリックして、 
ライトまたはライトコレクションに色
付けします。
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レンダリング
ショットをレンダリングするとは、カメラとライトを使用して 3D オブジェクトをデジタルで撮影し、 
画像または画像シーケンスを生成するようなものです。ゲームアーティストは、ゲームのシネマティクスのために 
レンダリングすることもあれば、高解像度から低解像度のオブジェクトにテクスチャをベイクするために、 
レンダリングすることもあります。

KARMA
Karma は物理ベースのレイトレーサーで、Solaris/LOP コンテキストで 
USD ファイルを扱えるよう設計されています。CPU 上で動作し、ディス
プレイスメントおよびサビディビジョンサーフェスのためのアダプティブ

（適応型）テッセレーション、マルチセグメントのモーションブラー、 
インスタンス化、ヘアーとファー、強力なボリュームレンダリングの 
サポートといった機能を備えています。 
Karma は、USD イメージングフレームワークである Hydra で機能し
ます。ビューポートで使用してインタラクティブに更新したり、Karma 
ノードを使用してディスクにレンダリングすることができます。

Karma は、VEX、USD Preview、Material X で作成したシェーダを扱え
ます。 

Karma XPU
Houdini 19.5 には、Karma XPU レンダリングエンジンのベータ版が
含まれています。この GPU/CPU のハイブリッドレンダラは、アルファ版
としてリリースされています。多くの機能は開発中であるため、この 
エンジンはテスト目的でのみ使用します。XPU は、Scene View の 
Display Options、または Karma ノードで選択できます。

Karma XPU では、USD Preview シェーダと Material X を扱えますが、
VEX には対応していません。

サードパーティ製レンダラ
USD をサポートする Solaris では、RenderMan、Autodesk Arnold、
V-Ray、Maxon RedShift、AMD ProRender といった他の Hydra  
デリゲートにレンダリングすることが可能です。

 

ビューポートレンダリング
Karma レンダラの主な利点の 1 つは、パースビューで使用できること
です。Karma を選択することで、インタラクティブなレンダリングが 
可能となり、Solaris/LOP コンテキストでライティングやルックデブに 
関する決定を下すことができます。

 

ビューポート | KARMA

レンダリング設定 - Karma LOP を使用して
レンダリング設定を定義し、ディスクにレンダ
リングできます。ここでは、ディスクにレンダ
リングする際のパスや、カメラ設定などを設
定します。

Karma LOP - Karma LOP を Solaris ノード
ネットワークの終端に追加します。この LOP 
のさまざまなバージョンを使用することで、 
テストレンダリングや最終ショットなど、それ
ぞれ異なる結果をセットアップできます。

MPlay - Karma と Mantra の両方から 
MPlay に直接レンダリングできます。または、
ディスクにレンダリングしてから MPlay で 
開き、結果を確認することも可能です。 
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レンダリング設定
ステージをレンダリングするときは、ビューポートのレンダリング設定
を使用します。レンダリングの最終的なルックを作成するには、Karma 
LOP を使用してフレーム範囲、カメラ解像度、デノイザ、より高画質の
レンダリング設定を設定します。 

RENDER GALLERY
Render Gallery を使用すると、スナップショットを撮って進行状況を
確認できます。各スナップショットには、ルックのすべての設定が含ま
れ、そのスナップショットと合致するようにシーンをいつでも戻すことが
できます。スナップショットにはラベルが付けられ、フィルタリングでき
るので、アクセスも簡単です。 

MANTRA
Mantra は、Solaris が導入される前に開発された Houdini のレンダラ
です。ジオメトリ、インスタンス、ボリュームの高効率なレンダリングが
密に統合された、物理ベースのレンダリングエンジンですが、Solaris/
LOP では動作しません。 

出力ノード
ショットをレンダリングするには、レンダリング出力ノードを作成する
必要があります。このためには、Render > Create Render Node > 
Mantra - PBR を選択します。 

また、Tab キーを使用して出力ネットワークに Karma ROP を追加す
ることもできます。この中には、オブジェクトレベルからすべての可視
オブジェクトを取得する LOP ネットワークが含まれています。 
ROP ノードを使用すると、ディスクまたは Mplay にレンダリングするこ
とができます。これらのノードには、サンプリング、ノイズレベル、全体
的なレンダリング品質など、最終画像を制御するためのパラメータが
多数含まれています。
オブジェクトやオブジェクトのグループごとに異なる ROP を設定できま
す。異なるノードを接続することで、ROP の依存関係を作成できます。
チェーンの最後のノードでレンダリングボタンを押すと、残りのすべて
のノードが先にレンダリングされます。 

レンダリング出力 | AOV
ROP には、画像平面をセットアップするためのコントロールが用意され
ており、Direct Lighting、Indirect Lighting、Shadows、Depth な
どのレンダリングレイヤーを作成できます。Karma と Mantra の両方が
これらのパスをレンダリングでき、Houdini のコンポジットコンテキスト
である COP や、Nuke などの外部コンポジットツールで読み込めます。 

Background Plate LOP を使用すると、背景が見透けるようにシーン
に穴をつくるマットオブジェクトをセットアップできます。このジオメトリ
は、影を受けたり、光に反射するため、オブジェクトがリアルに馴染み
ます。

MPLAY
MPlay では、Karma や Mantra 
などのレンダラでレンダリングし
た画像を確認できます。
メインメニュー - 画像または 
画像シーケンスをプレビュー用
に読み込みます。別フォーマット
で保存することも可能です。 
レンダリングレイヤー - この 
メニューを使用すると、color、
normal、diffuse_direct、
reflect-direct  など、さまざまな
レンダリングレイヤーを表示する
ことができます。
プレイバー - 画像シーケンスを
読み込んだ場合、これらのコント
ロールを使用して、シーケンスを
再生したり、スクラブすることが
できます。

Render Time - このビューに
直接レンダリングする場合も 
あるため、レンダリング時間 
情報が表示されます。
表示オプション - MMB ドラッグ
でパンしたり、RMB ドラッグで
ズームイン/アウトできます。
チャンネル - これらのボタンを
クリックすると、赤、緑、青、 
またはアルファチャンネルに 
集中したり、それらの組み合わ
せを確認することができます。
ガンマ設定 - ビューポートの輝
度、コントラスト、ガンマを設定
できます。デフォルトでは、リニ
アワークフローをサポートする
ガンマ値 2.2 が使用されます。
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プレイバー
プレイバーを使用すると、時間をスクラブしたり、キーフレームを設定および編集することができます。 
プレイバーでも簡易の編集が可能ですが、細部まで調整する目的ではアニメーションエディタを使用します。

現行時間
現行時間は、フィールドと 
フレーム範囲の黒のマー
カー上に表示されます。 
マーカーを使用してプレイ
バーをスクラブできます。 

フレーム範囲
全体の範囲は、左端のアニ
メーションコントロールボ
タンで定義します。表示範
囲は、範囲の下部にあるハ
ンドルを使って縮小するこ
とができます。

キーの編集
キーを設定すると、その
キーがプレイバーに表示さ
れます。Shift キーを押し
ながら LMB でキーを選択
してから、MMB でドラッグ
してキーを編集します。

キーの設定
Set Key ボタンをクリック
して、キーフレームを設定
します。小さい矢印をク
リックすると、Auto キーな
どのオプションメニューが
表示されます。

再生コントロール
再生、一時停止、次のキー
への移動を素早く行えま
す。その下には、アニメー
ションオプションやリアル 
タイム再生のボタンがあり
ます。 

時間とモーション
アニメーションは、経時的な変化を伴います。オブジェクトの位置、形状、色など、何であれ、時間の経過とともに 
変化させれば、それはアニメーションです。Houdini には、キーフレームベースのワークフロー向けのさまざまな 
ツールに加えて、時間とモーションをより高度に操作できる Motion FX と CHOP が用意されています。

  キーフレームの設定
キーフレームを使用すると、特定の時点に特定のパラメータ値を設定
することができます。パラメータ値が変化すると、シーン内のオブジェ
クトがアニメートされます。その後、アニメーションカーブを使用して、
キーフレーム間のモーションの品質を決定できます。以下に、Scene 
View で作業しながらオブジェクトにキーフレームを設定できる主な
ホットキーを紹介します。

	� キーフレームの設定	 K
	� AutoKey の切り替え	 Alt + K
	� ハンドルをキーフレーム	 Ctrl + K
	� 位置をキーフレーム	 Shift + T
	� 回転をキーフレーム	 Shift +R
	� スケールをキーフレーム	 Shift + E

パラメータエディタでキーフレームを設定することも可能です。 
Alt キーを押しながらパラメータ名またはパラメータフィールドをク
リックするか、パラメータを RMB クリックして Keyframes > Set 
Keyframe を選択します。こうすると、一度に 1 つのパラメータにキー
フレームを設定できます。

  プレイバー
プレイバーはメインのワークスペースの下部にあり、アニメーションを
再生したりスクラブできます。時間はフレーム単位で、デフォルトのフ
レームレートは 24 フレーム/ 秒です。 
左側には再生コントロールがあります。素早く再生をセットアップした
り、時間を操作するホットキーをいくつか紹介します。 

	� 再生	 
	� 逆再生	 
	� 次のフレーム	 
	� 前のフレーム	 
	� 開始フレーム	 Ctrl + 
	� 次のキーフレーム	 Ctrl + 
	� 前のキーフレーム	 Ctrl + 

プレイバーで、キーフレームを編集することもできます。プレイバーで
フレーム範囲を RMB クリックすると、キーを Cut、Copy、Paste する
オプションに加え、Replace、Cycle、Repeat、Stretch といった特殊
なペーストにもアクセスできます。これらのオプションにも独自のホッ
トキーがあり、メニューに記載されています。アニメーションエディタ
に移る前に、プレイバーでさまざまな作業を行うことが可能です。

チャンネル
アニメーションエディタでキーフレームを設定したり、アニメーション
カーブを表示するときには、チャンネルを操作することになります。 
キーフレームを設定したチャンネルを持つオブジェクトを選択すると、
そのチャンネルがアクティブになり、キーフレームがプレイバーや 
アニメーションエディタに読み込まれます。オブジェクトを選択解除 
すると、チャンネルをピン留めしない限り、それらのチャンネルも選択
解除されます。 
チャンネルをピン留めするには、プレイバーの右側、アニメーションエ
ディタの左側、またはチャンネルリストペインにあるチャンネルリスト
を使用します。このリストで 1 つまたは複数のチャンネルを選択するこ
とで、キーフレームを設定したり編集する対象のチャンネルを絞り込み
ます。 

チャンネルリストペイン
チャンネルリストペインでは、チャンネルグループ、アニメーションレ
イヤー、アクティブなチャンネルを扱うことができます。リストを使用し
てチャンネルのグループを作成すれば、アクセスがしやすくなります。
また、グループを使ってチャンネルをピン留めすると、異なるオブジェ
クトを選択した場合でもそのチャンネルを操作できます。これは、キャ
ラクタにキーフレームを設定する場合に便利なペインです。

  Flipbook
シーンをアニメートするとき、そのモーションをプレビューしたいことが
あります。Scene View の左側のツールバーにある Flipbook ツールを
使用すると、ビューポートからフレームをキャプチャして、その結果を 
リアルタイムでムービーとして再生できます。
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ONION SKINNING
Onion Skinning を使うと、現行のフレーム前後のフレームのオブジェ
クトをゴーストとして表示できます。Onion Skinning は、オブジェク
トの Misc タブでオンにします。Frames Before、Frame After、Frame 
Increment などのオニオンスキンのオプションは、ビューポートの 
Scene タブの Display パネル（d）で確認することができます。

  モーションパスハンドル
Pose ツールを使用してアニメートする場合、Motion Path オプション
をクリックしてハンドルを表示すると、選択したオブジェクトのアニメー
ションを時間経過に応じて確認できます。また、ハンドルを使用して
モーションの形状を操作することもできます。 

モーションパスハンドル

オニオンスキン

接線ハンドル

アニメーションエディタ
選択したチャンネルはアニメーションエディタに読み込まれ、キーフ
レームとアニメーションカーブ、またはスプレッドシートやドープシート
として表されます。キーフレームは選択と編集が可能で、カーブの形
状は接線ハンドルを使って調整できます。カーブはキーフレーム間の
モーションを定義するもので、モーションの質を定義するうえで重要な
役割を果たします。 
チャンネルを操作するときには、以下のホットキーを使ってキーフレー
ムやアニメーションカーブを確認できます。

	� すべてを表示 / ホーム 	 H
	� パン 	 MMB
	� ズーム	 RMB

Motion FX
キーフレームとアニメーションカーブはノードのパラメータに格納され
ますが、チャンネルオペレータ（CHOP）を使用すると、よりプロシー
ジャルなノードベースのアプローチでモーションを操作することができ
ます。 
最も簡単にチャンネルオペレータを作成するには、パラメータを RMB 
クリックして、Motion FX サブメニューから選択します。チャンネルリ
ストを使用して、これらのエフェクトをチャンネルグループに適用する
ことも可能です。

Motion FX は、Channel CHOP に抽出および格納される、キー
フレームによる動きに適用できます。その後、Cycle、Noise、
Smooth、Limit、Lag などのエフェクトを既存の動きに適用します。
Constraints シェルフにはさまざまなツールがあり、パラメータ設定に
よってターゲットの方を向くようにしたり、遅延させたり、微震するよう
にできます。

こうしたノンリニアなアプローチなら、非常に柔軟かつユニークな方法
でモーションを扱えます。

エディタオプション - この 
エディタは、グラフ、ドープシー
ト、テーブルの表示を切り替え
られます。
Channel Groups - グラフの 
この領域にはチャンネルグ
ループが表示され、簡単にチャ
ンネルを選択したりピン留め
できます。
Animation Layers - この 
領域では、複数チャンネルを
重ねて、異なるイテレーション
を作成できます。
Channel List - ここには選択
したオブジェクトのチャンネル
が表示されます。グラフで確認
したいチャンネル名を選択し
ます。

アニメーションエディタ

キーハンドル - 垂直バーを 
使用してキーを前後の時間に
移動したり、ボックスを使用し
て値を編集できます。
接線ハンドル - カーブの形状
を調整するために、キーフレー
ム前後の接線の角度を定義し
ます。
カーブ - アニメーションカーブ
は、キーフレーム間のモーショ
ンを定めます。これによって
モーションの質が決まります。
カーブ関数 - これらを使用し
て、アニメーションカーブや 
ハンドルのディスプレイオプショ
ンを設定できます。
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キャラクタリギングと FX
Houdini には、キャラクタやクリーチャを作成するための広範なリギングツールが搭載されており、 
それらを Houdini デジタルアセットにラップしてアニメータに渡すことができます。さらには、ヘアー、ファー、 
マッスル、布、群衆など、キャラクタのルックを向上させるためのキャラクタ FX ツールも備わっています。 

  BONES
Houdini では、Rigging シェルフにある Bones ツールと Bones 
from Curve ツールを使用して、ボーンを描画および編集できます。
ボーンチェーンはそれぞれ、チェーンルートとボーンで構成されてい
ます。他の 3D アプリがジョイントベースであるのに対し、Houdini 
は Length や Rest Angle のパラメータを持つ Bone ノードを使用し
ます。 
また、Bones ツールを使用すると、チェーンにインバースキネマティク
スを追加して、エンドエフェクタや、場合によってはツイストエフェク
タを加えることも可能です。キネマティクスは、独自のサブネットワー
クに存在するチャンネルオペレータ、つまり CHOP ノードによって 
駆動されます。

ジオメトリのキャプチャ
キャラクタのジオメトリをボーンにキャプチャして、リアルな動きを
表現するために必要な変形を作成できます。Houdini のボーンには 
Capture Region があり、ジオメトリを包含するようセットアップでき
るうえに、ジョイント部分には適切な重なりが作られます。このプロセ
スにより、ポイントにウェイトアトリビュートが割り当てられ、ボーンが
移動したり回転したりするときにジオメトリを制御する Deform ノード
に供給されます。

最初にキャプチャしたジオメトリは、希望するルックとは異なるでしょ
う。さまざまなツールを使用して、キャプチャウェイトを編集したり 
ペイントすることで調整していきます。ジョイントのウェイトを滑らかに
して、曲げをリアルにしていきます。また、Deform ノードに接続した 
DeltaMush ノードを使用して、ポイント変形の効果を平滑化すること
も可能です。
Bone Capture Biharmonic という新しいテクニックを使用すると、
広範なポイントウェイトがなくても、ジオメトリをキャプチャして、ジョ
イント部分を希望通りのルックにすることができます。この方法では、
四面体メッシュに Biharmonic（重調和）関数をセットアップすることで、
より全体的なソリューションが作成されます。 

デジタルアセットキャラクタ
Houdini キャラクタをリギングしてアニメーションチームと共有するに
は、ボーン、ジオメトリ、マテリアルを Houdini デジタルアセットにラッ
プする必要があります。 
これにより、ファイルがディスク上に作成され、アニメータは複数の
ショットで簡単に参照できます。ハンドルやキーパラメータはトップレベ
ルで操作が可能で、アニメータはリグの内部構造を気にすることなく、
キーフレームを設定できます。また、Pose Library や Character Picker 
のセットアップをアセットに保存して、素早くアクセスできるようにする
ことも可能です。

キャラクタのパーツに加えた変更はアセットに保存され、すべての
ショットが更新されます。この仕組みにより、堅牢かつ管理しやすいキャ
ラクタパイプラインが実現します。

  KINEFX
KineFX は、リターゲットやモーション編集にプロシージャルな基盤を
提供するキャラクタツールセットです。将来は、リギングやアニメーショ
ンにも拡張の予定です。ジオメトリコンテキストにおけるこの新しい
ワークフローは、限りない柔軟性とキャッシュ機能を備え、迅速かつ 
プラグアンドプレイのリギング体験を実現します。
ジオメトリ（SOP）コンテキストに実装された KineFX は、ジョイントを
通常のポイントジオメトリとして扱い、エッジ接続によってリグの階層
を定義します。Houdini のオブジェクトレベルからリグを取り込むこと
も、FBX キャラクタを読み込むことも可能です。
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チャンネルグループ
Houdini でアニメートする際は、スコープされているチャンネルにキー
フレームを設定したり、アニメーションエディタに表示することができ
ます。通常は、現在選択しているチャンネルがこれに該当します。また、
チャンネルグループはまとめることも可能です。チャンネルをスコープ
したりピン留めすると、キーフレームを設定しやすくなります。
キャラクタをデジタルアセットとしてセットアップしてある場合は、パラ
メータエディタの左上にあるアイコンをクリックし、Parameters and 
Channels > Create Nested Channel Groups を選択して、アセット
のフォルダ階層をガイドとしてグループを作成します。適切に設計され
たキャラクタアセットであれば、この作業は簡単です。

キャラクタ FX | ヘアーとファー
Add Hair ツールでキャラクタにヘアーを追加したら、Houdini のヘ
アーとファーのツールセットを使ってセットアップとグルーミングを行
います。これらのツールセットではガイドヘアーも使用できます。ワイ
ヤーシミュレーションでアニメートすると、リアルな仕上げになります。
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キャラクタ FX | マッスルとスキン
Houdini では、アニメートしたクリーチャにマッスルを追加し、シミュ
レーションを実行することなく、それらをスキンデフォーマとして適用で
きます。まず、ジオメトリコンテキストで Muscle ノードを使用して、 
シンプルなマッスルのフォームを作成します。 
その後、マッスルの形状と位置を調整し、キャラクタリグに取り付けた
ら、自動セカンダリアニメーションまたは Jiggle（微震）を有効にしま
す。Houdini のマッスルシステムは、統合されたデジタルアセットを使
用しながら、FEM（ダイナミクスシミュレーション）および非 FEM（スキン
デフォーマ）ワークフローに対応できるように設計されています。

群衆シミュレーション
群集シミュレーションは、キャラクタのスケルトン、スキンジオメトリ、
アニメーションクリップで構成されるエージェントから始まります。 
これらはポイントに割り当てられ、シンプルなルールの組み合わせに
よって複雑な挙動を作り出します。また、エージェントは他の動的要素
と相互作用が可能です。例えば、エージェントが走り過ぎる車にぶつ
かってラグドールになったり、群衆がフィールド上のアクションに反応
するようトリガを設定したりできます。 

CHARACTER PICKER
このペインでは、リグのパーツを
選択するためのインターフェース
を作成できます。これをファイルに
保存して、ディスク上のデジタル 
アセットファイルに追加することも
可能です。

タブ - 手、足、顔など、体のパー
ツごとにタブをセットアップでき
ます。

コントロール - リグの各ハンドルに
マーカーを配置し、テキストや 
カラーで区別できるようにします。

背景画像 - キャラクタの視覚表現
を追加して、マーカーと体のパー
ツを適切に関連付けられるように
します。

POSE LIBRARY
Pose Library ペインでは、後で参
照できるように、キャラクタのポー
ズやクリップをキャプチャすること
ができます。ポーズを適用するに
は、プレイバーでフレームに移動
し、ここで目的のポーズをクリック
します。

ポーズ - 単一フレームから取り込
んだポーズが保存されています。
そのポーズに設定されているすべ
てのパラメータが、現在のシーン
のキャラクタに適用されます。 
このポーズから別のポーズへの 
遷移を補間することも可能です。

クリップ - クリップには、一定期間
にわたるキーフレームが保持され
ています。例えば、歩行サイクル
やバク転などの特徴的な動きが含
まれます。
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ダイナミックシミュレーション
Bullet のリジッドボディ破壊、Pyro FX の火と煙、Vellum ソフトボディ、FLIP 流体などを作成するとき、 
Houdini では、統合されたダイナミクス環境を利用できます。異なるソルバ間で相互にやり取りできるため、 
結果についての制御がしやすい環境です。

シェルフツール
ダイナミックシミュレーションのセットアップには、ダイナミクスまたは 
DOP コンテキストのノードと、ジオメトリまたは SOP コンテキストの
ノードから成るネットワークが必要です。シェルフツールを使用すると、
これらのノードをすべて追加できるうえ、より少ないクリック数でシミュ
レーションをセットアップできるので、とても便利です。セットアップし
たら、ネットワークの中に入り、それぞれのノードを確認できます。

シェルフツールは、ノードグループを自動的にセットアップしたい場合
に適しています。シェルフツールによって構築されたネットワークの構
成を確認しておくと、DOP ネットワークをゼロからセットアップする際
に役立ちます。

ダイナミクスソルバ
シミュレーションの中心は、ダイナミクスソルバです。シミュレーション
の頭脳として、すべてのダイナミクスオブジェクト、フォース、衝突オブ
ジェクトを受け取り、それらを統合して最終結果を作ります。シェルフ
ツールは、ソルバをダイナミックネットワークに組み込み、ノードを接
続してくれます。

 Rigid Body Solver - 効率的な Bullet ソルバや Houdini の組み込みソル
バを使用して、リジッドオブジェクトの落下や衝突をシミュレートします。 

 Static Solver - オブジェクトを衝突ジオメトリとして機能させたいが、 
シミュレーションの影響を受けないようにしたい場合に使用します。 

 Flip Solver - FLIP 流体シミュレーションによって、しぶきや波のエフェク
トを作成します。

 Whitewater Solver - FLIP の計算が完了した後、このソルバを実行する
ことで Foam（泡沫）、Spray（飛沫）、Bubble（泡）を作れます。

 Vellum Solver - POP Solver の一種で、布、ヘアー、粒、流体、風船な
どのソフトボディに対して統合的に対応しています。

 POP Solver - パーティクルや粒に使用され、さまざまなパーティクルベー
スのシナリオを幅広くシミュレートします。粒のシミュレーションは、ソフトボ
ディや布の類のシミュレーションにも使用できます。

 Wire Solver - ヘアーやファー、船の索具や木の枝などのワイヤー状の 
オブジェクトに使用できるソルバです。

 Finite Element Solver - 連続体や四面体で定義されるソリッドの力学を
シミュレートします。このソルバは、筋肉、ソフトボディシミュレーション、折れ
る木をはじめとする破壊ショットに使用されます。

 Cloth Solver - キャラクタなどの変形ジオメトリと衝突する布シミュレー
ションを作成します。

 SOP Solver - SOP ネットワークを使用して、オブジェクトの形状を時間の
経過とともに変化させます。オブジェクトがぶつかってへこむ壁などをシミュ
レートできます。

OPENCL
POP Grains ノード、Pyro ソルバ（Advanced タブ）、FLIP Solver

（Volume Motion > Solver タブ）などのソルバで OpenCL を使用
する場合、GPU を使用するとシミュレーションが高速化できます。

フォース
ダイナミックな動きを作るには、動きのためのフォースが必要です。 
最も基本的なフォースは重力ですが、扇風機、流体、磁石などの外部
フォースも、シミュレーションの動きに寄与します。

 Gravity Force - オブジェクトが重力フィールド内にあるかのように、 
オブジェクトに下向きのフォースを適用します。 

 Drag Force - 現行のモーションに抵抗するフォースと回転モーメントを 
オブジェクトに加えることで、減速させたり、運動量を小さくしたりします。

 Uniform Force - 正確な量のフォースと回転モーメントをオブジェクトに
適用します。Noise DOP によって増強し、乱流を追加することもできます。

 Fan Force - 円錐状のフォースをオブジェクトに加えます。
 Fluid Force - 流体によって布やワイヤーなどのソフトボディを変形します。
 Wind Force - 押す力によってオブジェクトの Velocity を上げますが、 

風自体の速度を越えることはありません。
 Magnet Force - メタボールで定義したフォースフィールドを使って、 

オブジェクトを引き寄せまたは遠ざけます。 
 Vortex Force - 渦巻きのようなフォースを作成して、竜巻周辺のオブジェ

クトのように、カーブを軸にオブジェクトを周回させます。

ダイナミクスオブジェクト
オブジェクトを選択し、シェルフツールを使ってシミュレーションに追加
すると、Houdini はダイナミクスオブジェクトを作成します。ダイナミク
スオブジェクトは、オブジェクトのジオメトリを使用して、密度、摩擦、
跳ね返りなどのダイナミクスプロパティを追加します。

アクティブと Static（静的）
アクティブなダイナミクスオブジェクトは、フォースや衝突の影響を受け
ますが、Static オブジェクトは影響を受けません。アニメーションジオ
メトリや変形ジオメトリを使用したい場合は、ダイナミックオブジェクト
の Initial Object Type メニューまたは Use Deforming Geometry 
チェックボックスを使用して、これを定義する必要があります。

32

HO
UD

IN
I F

OU
ND

AT
IO

NS



衝突
衝突オブジェクトも、シミュレーションに大きく関係する要素です。 
地面をセットアップして、衝突用に連続したサーフェスを作成したり、
静的または変形するオブジェクトを使用できます。

それぞれのダイナミクスオブジェクトに、衝突ボリュームを表示したり
最適化するための設定があります。衝突の精度はできるだけ高くした
いものですが、それに応じてかかるシミュレーション時間の長さとの 
バランスも考慮します。 

リジッドボディ拘束
Rigid Bodies シェルフには、シミュレーションにも影響させられる 
拘束が多数あります。例えば、Pin、Spring、Slider などの拘束です。 
また、リジッドボディシミュレーションのセットアップ時に Glue 
Objects を使用すると、接着を「弱める」か、衝突が発生するまで、 
オブジェクト同士を接着しておくことができます。

プレイバーの表示
シミュレーションを開始するには、プレイバーで Play を押します。 
シミュレーションが進むと、プレイバーがハイライトされ、どれくらいの
シミュレーションがメモリにキャッシュ化されたかが分かります。 
その後、再度シミュレーションを実行することなく、その領域をスクラブ
できます。 

ディスクへのキャッシュ化
シミュレーションが完了したら、DOP 内から sim ファイルを保存して
ロックします。また、File Cache ノードを使用して、シミュレーション
ジオメトリを bgeo シーケンスに書き出すことも一般的な方法として 
使われています。こうすると、プロダクションのライティングやレンダリ
ングの段階で、シミュレーション結果を扱いやすくなります。 

ゲーム向けリアルタイム FX
ゲームでは、爆発などのエフェクトをゲームエンジンでリアルタイムに
最適化する必要があります。リジッドボディ、Pyro FX、流体など、さま
ざまな種類の Houdini シミュレーションをゲーム用のアートに変換す
る方法については、SideFX Labs ツールを確認してください。 

シェルフツールを使用してダイナミク
スオブジェクト、衝突オブジェクト、 
またはフォースを作成すると、 
全パーツを組み合わせた 
AutoDopNetwork が作成されます。

Static Object - これらのノードは、
地面や静止衝突オブジェクトのプロ
パティをセットアップします。

Static Solver - ダイナミクス 
オブジェクトが入力オブジェクトと 
相互作用する間、入力されるオブジェ
クトを静止したままにします。

Merge ノード - ダイナミクスシステム
の複数の部分を結合します。 
シミュレーション中、すべてが相互に
作用するように、ノードはチェーンの
上流と下流で評価されます。

AUTODOPNETWORK

ダイナミクスオブジェクト -  
このノードはジオメトリを DOP に
取り込んで、基本のプロパティを
割り当てます。

Rigid Body Solver - 関係する 
オブジェクトのシミュレーションを
生成するソルバです。

フォース - 重力や風などのフォー
スを使用して、ダイナミクスオブ
ジェクトに影響を与えるノード
です。

Output ノード - このノードを
使用すると、シミュレーションを
キャッシュ化したい場合に .sim 
ファイルを出力できます。
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Cloud FX とボリューム
Houdini のビジュアルエフェクトで重要なのは、ボリュームデータの使用です。Houdini では、ボリュームは 
内部的にツールの機能をサポートしますが、ボリュームが何であるか、さらにはボリュームを直接扱う方法を学ぶ 
ことをお勧めします。

ボリュームでは、ポイントやポリゴンではなく、ボクセルを使用して 
オブジェクトを表現します。ボクセルは 3 次元ピクセルです。立方体の
グリッドを構成する各ボクセルには、ボリュームの表示方法を示す情報
が含まれ、うっすらとした雲のような形状の表現にも適しています。 
ボリュームベースのオブジェクトの視覚的な品質は、3D グリッドの解
像度に応じて決まります。解像度が高いほど、品質は高くなりますが、
パフォーマンスに影響があります。

 

ISO OFFSET
Isooffset ノードはジオメトリコンテキストにあり、マニフォールド（多
様体）のポリゴンジオメトリを受け取って、Houdini が使用できる 
Houdini ボリュームを構築します。さまざまな Output タイプが選択可
能で、フォグや四面体メッシュとして形状を表示することができます。

元のジオメトリ フォグ 四面体メッシュ : 立方体

CLOUD FX
このツールセットは、ジオメトリを雲のような VDB ボリュームに変換し、
ライティングを施します。Cloud Rig ツールは、個々の雲を形成するだ
けでなく、Cloud、Cloud Noise、Cloud Light など、最終的なルック
に寄与する低レベルツールを理解するためにも役立ちます。

構築されたネットワークは、雲のソースを読み込んでから他のノードを
適用することで、Houdini ボリュームと VDB による雲のようなエフェク
トを作成します。Houdini には、空をボリュームクラウドで埋め尽くす 
Sky Rig ツールも用意されています。

Unreal などのゲームエンジンで使う雲の風景を作成するには、
Houdini で Sky Rig を使用し、それをメッシュに変換すれば、生成
サーフェスとして使用できます。このアプローチに関しては、SideFX 
の Web サイトで Andreas Glad によるチュートリアルを確認してくだ
さい。

OPEN VDB
「OpenVDB」は、アカデミー賞を受賞したオープンソースの C++  
ライブラリで、3 次元グリッド上に離散化されたスパースボリューム
データを効率的に格納および操作するツール群で構成されています。
DreamWorks Animation 社によって開発およびメンテナンスされて
おり、長編映画制作でのボリュームアプリケーションでよく使用され
ます。- openvdb.org

Houdini には、さまざまな OpenVDB ボリュームノードがあり、ジオメ
トリをボリュームに変換するジオメトリ（SOP）ネットワークで利用でき
ます。

内部的なボリューム
Houdini のツールの多くは、見えないところで、つまり内部的にボ
リュームを使用しています。以下は、ボリュームが作業に寄与している
例です。 

	� コライダ - デフォルトで、ボリュームはダイナミックシミュレーション用に
ジオメトリをコライダに変換します。

	� シミュレーションフィールド - ボリュームは、ダイナミックシミュレーショ
ンに寄与する Density（密度）や Velocity（速度）などのフィールドを定義し
ます。 

	� ヘアーとファーのツール - これらのツールは、グルーミングの計算を支援
するためにボリュームデータを使用します。

	� 地形 - Height Field ツールは、それぞれのボクセルに各グリッドポイント
での地形の高さを含む 2D ボリュームを使用します。

	� レンダリング - ボリュームは、Mantra で Water Depth（waterdepth）と 
フォグのエフェクトを作成します。
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地形と Height Field
Houdini の一連の heightfield ノードを使用すると、プロシージャルに地形を生成できます。形状を重ねたり、 
ノイズを追加したり、侵食のシミュレーションを実行することで、デジタル景観のルックを定義できます。 
このワークフローはコンポジットに似ていますが、すべての作業を 3D 形状で行います。

Houdini には、地形を生成および形成するための各種ジオメトリノー
ドが用意されています。これらのツールは、2D ボリュームを使用して
地形を表現し、各ボクセルにはそのグリッドポイントでの地形の高さ、
つまり Height Field が含まれています。ジオメトリネットワークに 
渡されるデータには、複数の Height Field を含めることができます。
これらのツールには、Terrain デスクトップからアクセスできます。 
Houdini のビューポートでは、2D Height Field を 3D サーフェスとして
視覚化でき、マスクフィールドは 3D サーフェス上に赤色で表示されま
す。Height Field のレンダリング専用の Mantra プロシージャルがあり、
ダイナミックシミュレーションでは衝突サーフェスとして使用できます。

ARON KAMOLZ

パターン
Heightfield ノードを配置して基本の解像度を定義すると、
Heightfield Pattern ノードを使ってさまざまな初期形状にアクセス
できます。線形、同心円、放射状のランプ、線形階段、星などの放射
状に対称的な形状、ボロノイセルなどをセットアップできます。
これらの形状をブラーさせたり歪ませて、地形の開始点となる形状を
作成します。また、複数の要素を組み合わせたり重ねることで、さらに
洗練された結果に仕上げることも可能です。 

ノイズ
地形を構築する際に、レイヤーにノイズを追加して自然なルックにする
ことができます。Perlin、Sinusoid、Worley  など、さまざまな種類の
ノイズが用意されています。地形のリアルさが増すだけでなく、さまざ
まなノイズを適用した複数の形状を組み合わせることで、多様性に富
んだハイパーリアルな結果を得られます。

マスク
Height Field ツールはまた、それぞれのボクセルにマスクレイヤー
を含む 2 次的なタイプの 2D ボリュームも使用します。ほとんどの 
Terrain ノードは、2 番目の入力でマスクレイヤーを受け取り、そのノー
ドが変更する地形の領域をマスクによって制御します。
マスクの利用方法はさまざまあり、マスクを使用することで、ディテー
ルの追加や地形の形成が行いやすくなります。Height Field にマスク
をペイントすることも可能です。 

浸食
Heightfield Erode ノードは、雨量、土壌の侵食性、エントレインメン
ト率を変数として使用することで、侵食や堆積をシミュレートします。
このノードは、プレイバック中に反復的に動作します。最初のフレーム
では何の影響も受けていないように見えます。浸食のシミュレーション
を確認するには、プレイバーで Play を押す必要があります。 

エクスポートオプション
ゲームエンジンなどの他のアプリケーションで使用するために、地形
をエクスポートする方法は 2 通りあります。Heightfield Output ノー
ドを使用すると、Height / マスクレイヤーを画像としてディスクにエク
スポートし、テクスチャとして取り込むことができます。 
あるいは、Houdini デジタルアセットを作成し、Houdini Engine プラ
グインを使用して Unreal や Unity などのアプリケーションで開くこと
も可能です。これらのデジタルアセットは、ゲームエンジンの組み込み
の地形ツールで扱うことができます。
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SideFX Labs
SideFX Labs は、Houdini のアーティストおよびゲーム開発関連の向けワークフローの高速化を目的とした、 
ハイレベルなツール群です。メッシュ処理、リアルタイム FX、UV 編集、シミュレーションからのモーションベクトル 
作成など、開発中のツールも多数あります。 

Houdini のすべての機能は映画、TV、ゲームのコンテンツ制作に 
使用できますが、Labs ツールセットは、現在の Houdini では対応が
難しい、アーティスト固有のタスクにも対応できます。通常の Houdini 
開発サイクルとは別に開発されており、テスト目的での試用が可能に
なった時点で提供されます。Houdini 内から直接ダウンロードするか、
SideFX Labsの GitHub ページからアクセスできます。

ツールのダウンロード
Labs ツールは、Houdini と一緒にインストールすることも、SideFX 
Labs シェルフタブからアクセスすることもできます。たいていはデスク
トップに表示されないため、追加するための操作が必要です。表示さ
れたら、Update Toolset ボタンをクリックします。すると、インストー
ルを促すダイアログが表示されます。ツールの多くがベータ版のため、
このときには Production Builds Only オプションをオフにします。

 

シェルフにはツールのほとんどが表示されますが、ビューポートやネット
ワークビューで Tab を押した場合にのみ利用できるツールもあります。
こうしたノードは、識別しやすいように先頭に Labs が付いています。

FX ツール 
Houdini は強力な FX ツールで知られていますが、SideFX Labs には、
ゲームまたはバーチャルプロダクションなどのリアルタイム環境で使用
するために結果を処理するツールがあります。また、シミュレーション
を最適化して、テクスチャ、FBX、CSV などに出力する各種ツールもあ
ります。

 Vertex Animation Textures - Vertex Animation Textures ROP は、布、
リジッドボディ破壊、流体、パーティクルの複雑なアニメーションを再生する、 
リアルタイムマテリアルで使用するメッシュとテクスチャをエクスポートし
ます。

 

 Flipbooks Texture - Pyro FX 向けテクスチャアトラスを作成およびプレ
ビューできる、高速 GL または Karma ベースのツールです。

 Destruction Cleanup - リジッドボディのシミュレーション結果をエクス
ポートする前に、余計なジオメトリを削減し、法線を整え、アトリビュートを
整理します。

 Skinning Converter - Skinning Converter は、トポロジが変わらない変
形メッシュシーケンスをボーンベースのアニメーションに変換する SOP です。

 Make Loop - アニメートさせたメッシュ、ポイント、ボリュームを受け取っ
てループにします。

 Volume to Texture - Volume Texture ツールを使用すると、Ryan 
Brucks 氏による UE4 のボリュームプラグインで使用可能なテクスチャを書き
出せます。

 Flowmap - このユーティリティツールは、入力ジオメトリ上にフローマッ
プテンプレートをセットアップします。

 Flowmap Visualize - Houdini ビューポートでのフローマップテクスチャ
の高品質リアルタイムプレビューです。

 Flowmap Obstacle - Flowmap Obstacle SOP を使用すると、障害物ジ
オメトリに基づいてフローマップを簡単に修正できます。

 Niagara ROP - 弾丸シミュレーションから衝撃、分割データ、補間データ
を抽出および書き出して、UE4 Niagaraデータインターフェースで使用できる
ようにするオールインワン HDA です。

 Gamedev Procedural Smoke - Procedural Smoke SOP は、煙を表現
したアニメーションボリュームを生成します。

 ROP Vector Field - ボリュームまたはポイントクラウドから、UE4 と互換
性のあるベクトルフィールドを生成します。

メッシュ処理
高精度のメッシュをゲームに取り込むまでには、フォトグラメトリ、トポ
ロジのクリーンアップ、メッシュのリダクション、UV レイアウト、マップ
のベイクなど、いくつものステップがあります。Labs ツールを使用と、
ワークフローをまとめ、一般的なソフトと統合することで、このプロセ
スを簡略化できます。

 AliceVision Photogrammetry - AliceVision は、3D 再構築とカメラ追
跡アルゴリズムを提供する、フォトグラメトリのコンピュータビジョンフレーム
ワークです。

 ZBrush Bridge - GoZ は Zbrush の高速ファイル転送機能です。ファイル
のパスや拡張子といった設定なしに、Houdini と Zbrush 間で、シームレスに
メッシュを送信できます。 

 Delete Small Parts - 接続性とサイズに基づいてパーツを削除します。
 Delight - 高解像度のフォトグラメトリスキャンに含まれる、アンビエント

ライティング情報を除去します。
 GameRes - 高解像度モデルを低解像度モデルにする、フルパイプライン

ノードです。
 Maps Baker - ほぼインタラクティブな速さで、高解像度モデルから低解

像度モデルへのテクスチャベイクを生成します。
 LOD Hierarchy - LOD 階層を作成して FBX としてエクスポートします。 
 Mesh Sharpen - メッシュの曲率に基づいてジオメトリを鋭くします。 
 Edge Damage - ジオメトリのエッジに摩耗を加えます。 
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ワールドの構築 
デジタルワールドはより大きく、より複雑になっています。効率的な 
ワールド構築ワークフローを用いることが重要です。ニューヨークを 
再現したい、密林を育てたい、SF アドベンチャーに屋内のディテール
を加えたい。このようなときが、Lab ツールの出番です。

 Physics Painter - Physics Painter は、ユーザが他のオブジェクト上に 
物理オブジェクトをペイントできるようにする SOP です。

 Building Generator - ユーザ定義モジュールのライブラリを使用して、
低解像度のブロックアウト（枠組み）ジオメトリを詳細なビルに変換します。

 OSM Import - Open Street Map は、街路データの優れたデータベース
です。このノードは、OSM ファイルや、ビルや道路のさまざまなタグ付きアト
リビュートをすべて効率的に Houdini にロードします。

 OSM Buildings - OSM データからビルを生成します。
 Tree ツール - Labs の Tree ツールにはいくつかのツールがあり、組み合

わせて使用することで木、茂み、植物などの複雑な枝構造を作成できます。
 Cable Generator - ケーブルの高い位置の「ピン」ポイントと低い位置の

「垂れ」ポイントを表現したカーブを与えると、この SOP はユーザ定義可能
なケーブルの本数、形状、色で垂れ下がったケーブルを生成します。

 Curve Branches - カーブ上にカーブを散乱させます。いくつもの直感的
なコントロールを使用して、クリーンな幾何学的な枝から有機的なブドウの
枝までを表現可能です。この SOP を複製してチェーン接続すれば、再帰的成
長を表現でき、L-System のようなルックをより柔軟な制御で得ることができ
ます。

 Dirt Skirt - オブジェクトと地面が交差した箇所にジオメトリ「スカート」を
作成します。これは、ゲームエンジンでソフトブレンドとして使用します。

 Lot Subdivision - ポリゴンをパネルに分割します。市街地の作成やディ
ティールアップに便利です。

 MapBox - mapbox.com で提供されているデータを使用して、色、高さ
が定義された Open Street Map（OSM）カーブを生成します。

 SciFi Panels - SF 風のパネルを生成するサンプル HDA です。
 Snow Buildup - 入力メッシュに積雪を模倣したジオメトリを追加します。
 Terrain Texture Output - Terrain Texture ROP SOP は、Height Field 

から画像データをレンダリングします。

モデリング
Labs ツールには、ゲーム用のジオメトリを簡単に作成できるように 
設計された、さまざまモデリングツールがあります。

 Decal Projector - デカール（局所的なジオメトリとテクスチャ）をジオメト
リ上に投影します。

 Calculate Slope - 方向と比較してサーフェスの勾配を計算し、オプショ
ンでその結果をブラーしたり再マップすることができます。

 Curve Sweep - プロファイルのタイプ、幅、捻じりの挙動の単純なコント
ロールを使って、入力カーブに沿ってプロファイルを回転させます。

 Extract Silhouette - XYZ のいずれかの軸から投影されたオブジェクトの
アウトラインを作成します。

UV マッピング
テクスチャ UV は、ゲームアート作成で大きい割合を占める作業工程
です。これらのツールは Houdini の既存の UV ツールセットを強化す
るもので、より素早く効率的に作業できるようにします。

 Auto UV - 自動的にオブジェクトにシーム（継ぎ目）を生成し、UV Flatten 
を即時に実行します。

 Inside Face UVs - 破壊されたジオメトリの内部フェースに UV を生成します。
 UV Transfer - ソースジオメトリとターゲットジオメトリの間で UV を転送

します。
 UV Visualize - UV を視覚化するヘルパースクリプトです。シーム（継ぎ目） 

の視覚化、UV 空間とモデリング空間の間のワープ、グリッドテクスチャのタイ
リングの変更、島の視覚化といった機能が含まれます。

 Texel Density - このツールは、アセットとプロジェクトの解像度に基づい
て、プリミティブ単位でアセットの現行テクセル密度を計算します。 

インテグレーション
これらのツールは、Houdini とゲームエンジンの間でのインポート・ 
エクスポートが簡単になります。

 Substance COP - Houdini 向け Substance プラグインを使用すると、
Substance Archive ファイルを Houdini の COP に読み込むことができます。

 Rizom UV - RizomUV Bridge は、4 種類の SOP のセットで、Houdini と 
RizomUV 間のやり取りを簡易化します。

 Quad Remesher - QuadRemesher ノードは、Exoside 社の 
QuadRemesher コマンドラインインターフェースのラッパーです。

 Instant Meshes - DDS（DirectDraw Surface）ファイルを読み込みます。
 Sketchfab - ジオメトリを Sketchfab にアップロードします。
 3D Facebook Image - 3D シーンを Facebook にアップロード可能な 

2.5D 画像に手早く出力できます。
 Marmoset ROP - Marmoset ROP を使うと、Houdini 内で手軽に mview 

を生成できます。
 Gaea Tor Processor - Gaea Tor Processor を使用して、Gaea で作成さ

れたビルドの .TOR ファイルをロードできます。

UX
Labs ツールの中には、Houdini を使用するアーティストのユーザエク
スペリエンスの向上を目的に作られたものもあります。

 Crash Recovery - File メニューにあるこの機能は、不運にもクラッシュ
してしまったファイルを素早く修復します。

 Network Paint - ネットワークエディタで描くだけで、カラフルな注釈を
ネットワークに追加できます。

 Sticker Placer - 数字、アイコン、ユーザが作成したグラフィックスを配置
して、ネットワークに注釈を付けることができます。

 External Script Editor - VEX、Python、OpenCL、エクスプレッションを
扱う際に、外部 IDE とのライブ接続をセットアップできます。

その他
他にもさまざまなツールが追加されています。SideFX.com/labs をご覧くだ
さい。
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ファイル管理
アーティストとして成功するには、Houdini での作業で作成したすべてのファイルの管理方法を理解することは、 
とても大切です。一般的なシーンファイルは、ディスク上で外部依存関係を持っていることがあります。 
ファイルを別のコンピュータに移動する場合には特に、これらの管理が重要になってきます。

プロジェクトディレクトリ
Houdini はハードドライブ上に散在するファイルを扱うことはできます。
そうすると、作業内容を共有したり、ファイルの依存関係を管理するの
が難しくなってしまいます。File > New Project を使用してプロジェ
クトディレクトリをセットアップするか、File > Set Project を使用して
既存のプロジェクトディレクトリを作業の「ホームベース」として選択し
ましょう。こうすると、必要なプロジェクトファイルすべてに、ローカル
の依存関係が簡単にセットアップできます。

シーンファイル | .hip
Houdini で主に使用するファイルタイプは、.hip ファイルです。このファ
イルには、すべてのノードとネットワークが含まれています。作業内容
を保存する際は、このファイルタイプを使用します。

UNIVERSAL SCENE DESCRIPTION | USD
Houdini では、Solaris のライティングとルックデブ環境は、PIXAR が
作成したオープンソースイニシアティブである USD（Universal Scene 
Description）を使用しています。Solaris では USD がネイティブであ
り、プロシージャルノードを使用して、参照、ペイロード、レイヤー、 
コレクション、バリアント、詳細レベルを管理できます。

Houdini デジタルアセット | .hda
Houdini ネットワークをカプセル化し、Houdini デジタルアセットつま
り .hda ファイルに保存することも可能です。アセット内のパラメータを
トップレベルにプロモートして、アセット用のカスタム UI を作成できま
す。これらのファイルは他のアーティストと簡単に共有でき、プロジェ
クトのライフサイクルを通じてアセットが発展していく間も、堅牢な参
照アーキテクチャを提供します。

アセットの作成と読み込みには、Asset メニューを使用します。 
また、シーンに読み込まれたアセットは、そのメニューにある  

Asset Manager を使用して管理できます。シーンに読み込まれた 
2 つの HDA ファイルが同じ名前の場合、Houdini はマネージャで設定
されたルールに基づいてどちらかを選択します。HDA ファイル内のア
セット定義に加えられた変更は、そのファイルを参照するシーンに自
動的に反映されます。なお、古いデジタルアセットファイルは拡張子が 
.otl の場合がありますが、機能は .hda ファイルとまったく同じです。

APPRENTICE と INDIE ファイル
Houdini Apprentice と Houdini Indie は、商用バージョンの Houdini 
では開くことができない、別のファイルタイプを使用します。Apprentice 
はシーンに .hipnc（non-commercial : 非商用）、アセットに .hdanc ファ
イルを使用し、Indie はシーンに .hiplc（limited commercial : 限定的な
商用）、アセットに .hdalc ファイルを使用します。

作業のバックアップ
デフォルトでは、Houdini は保存するたびに、シーンファイルとデジ
タルアセットファイルの番号付きのバックアップを作成します。前のイ
テレーションを見直したい場合や、作業ファイルに問題があった場合
は、そのファイルに戻ることができます。また、Edit > Preferences > 
Save and Load Options で Houdini を AutoSave に設定することも
可能です。なお、これらのバックアップファイルはディスク容量を消費
するため、時々削除しましょう。 

FILE SOP
File > Import > Geometry を使用してジオメトリを Houdini にイ
ンポートすると、ジオメトリ（SOP）レベルに File ノードが配置されま
す。このファイルはディスク上のファイルとの接続を維持し、ファイルに
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変更が加えられると、Houdini シーンも更新されます。接続を解除し
たい場合は、File ノードをロックする必要があります。 

ファイルの依存関係（$HIP/$JOB）
ジオメトリやテクスチャファイルなど、ディスク上のファイルを参照する
ノードを使用している場合には、プロジェクトディレクトリを別のコン
ピュータやクラウドに移動した場合にどうなるかは、パスによって決ま
ります。絶対パスは、ファイルを移動すると切れてしまいます。したがっ
て、シーンファイルをパスの「ホームベース」として使用する $HIP や、
プロジェクトディレクトリを使用する $JOB を使用する必要がありま
す。シーンファイルが適切にセットアップされているかどうかを確認す
るには、Render > Preflight Scene を使用します。

ディスク容量の管理
巨大なシーンファイル、バックアップファイル、大規模なシミュレーショ
ンは、かなりのディスク容量を消費します。ディスクの容量を使いすぎ
て、コンピュータが不安定にならないように注意してください。容量が
大きいファイルは外部ドライブに保存し、コンピュータのメインディスク
には日常業務をこなすのに十分な容量を残しておきます。

相互運用性
Houdini からインポートしたり、エクスポートする際に使用できるファ
イルフォーマットは、多数あります。一般的な Houdini パイプラインで
使用される主なフォーマットを紹介しましょう。

Houdini ファイル - Houdini でのみサポートされるファイルフォーマッ
トをいくつか紹介します（.hip と .hda を除く）。 
.bgeo - ジオメトリと UV、Velocity、法線などの関連アトリビュートを保存
するフォーマットです。アニメーションやシミュレーションを番号付きの bgeo 
ファイルとして保存することで、動きも保存可能です。bgeo.gz ファイルは、 
このフォーマットの圧縮バージョンです。

.sim - シミュレーションデータを保存して、シミュレーションをディスクに
キャッシュ化することができます。このファイルも使用できますし、.bgeo で 
シミュレーションをキャッシュ化することも可能です。

.ifd - Mantra でレンダリングする際に作成されるシーン記述フォーマットで
す。通常、このファイルは Houdini でレンダリングする際に作成されますが、
ディスクに保存して Mantra で直接レンダリングすることもあります。

.pic - Houdini で使用されていた古い画像ファイルフォーマットです。デフォル
トのフォーマットは、オープンソースの EXR に置き換えられました。 
.rat - この画像フォーマットは、Mantra でレンダリングされるテクスチャマップ
に最適です。すべてのテクスチャはいずれこのフォーマットに変換されるので、
MPlay を使ってこのフォーマットに変換すると、レンダリングが高速化します。

画像フォーマット - ショットのレンダリングやテクスチャマップには、こ
れらの業界標準のフォーマットが使用されます。
.exr - OpenEXR は、Industrial Light & Magic 社が開発したハイダイナミック
レンジ（HDR）画像ファイルフォーマットです。Houdini のレンダリングを保存
する、デフォルトのフォーマットです。 

.jpg/.png - 画像を Web にパブリッシュする際に使用されるフォーマットです。 

.tga/.tif - ビデオゲームのテクスチャマップによく使用されるフォーマットです。 

ジオメトリフォーマット - ジオメトリのインポートとエクスポートでは、
次のフォーマットが最も一般的です。
.usd - Solaris/LOP で使用されるフォーマットで、他のアプリケーションと 
共有するためのオープンソース交換フォーマットでもあります。
.abc - Alembic は、オープンコンピュータグラフィックス交換フレームワーク
です。 
.fbx - Autodesk 社が所有するフォーマットで、ゲームエンジンや他の 3D アプ
リケーションとデータをやり取りする際によく使用されます。ジオメトリ、リギ
ング、モーションおよびシェーダ情報を保持できます。 

.obj - Wavefront 社が独自に開発したシンプルなジオメトリフォーマットです。

プリフライトパネル
Render メニューから Pre-Flight Scene を 
選択して、シーンのセットアップを評価できます。

参照ファイル - プリフライトパネルでは、$HIP  
または $JOB のどちらかを参照して、シーンファ
イルのファイル参照を確認することができます。

緑でハイライトされた参照 - $HIP や $JOB に 
対する相対参照は緑で表示され、正常に機能 
していることが示されます。

不正確な参照 - ファイル参照が絶対パスであり、
$HIP や $JOB に対する相対参照でない場合は、
赤で表示されます。プロジェクトを他のアーティ
ストと共有したり、クラウドで共有する場合は、
事前に修正する必要があります。

Edit Expression - 任意のファイル名をクリック
し、エクスプレッションを右クリックすると、Edit 
Expression ウィンドウが開きます。
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エクスプレッションとスクリプト
Houdini はプロダクションレベルのソリューションであるため、作業ではスクリプトが重要な役割を果たします。 
アーティストはエクスプレッションを書くだけで十分なことがほとんどである一方、テクニカルディレクターは 
より長い時間をこうしたテクニックに費やすことになります。Houdini は、Hscript、Python、VEX をサポートして 
います。

HSCRIPT エクスプレッション
HScript は、エクスプレッションの記述に使用できる情報を取得および
操作するための、素早く簡潔な方法となるように設計されています。 
エクスプレッションとは通常、単純な文字列や数値ではない、任意の
値です。これは、変数のような単純な場合もあれば、方程式やエクス
プレッション関数である場合もあります。

フィールドにタイプするだけで、パラメータに直接エクスプレッションを
入力することができます。Enter を押すと、フィールドが緑でハイライト
されます。パラメータ名をクリックするだけで、エクスプレッションと 
エクスプレッションの結果を切り替えられます。
チャンネル参照を作成する場合は、パラメータを RMB クリックして 
Copy Parameter を選択し、リンクさせたいパラメータに移動して 
Paste Relative References を選択します。
また、2 つ目のパラメータを RMB クリックし、Reference > Scene 
Data を選択しても同じです。表示されるパネルで、他のオブジェクト
やノードからデータを選択すると、エクスプレッションが構築されます。
この方法で、複数のパラメータにエクスプレッションを設定することも
可能です。

エクスプレッションエディタ
関数の複雑さやパラメータの種類によっては、エクスプレッションエ
ディタを使用することもできます。エクスプレッションエディタを開くに
は、パラメータを RMB クリックして Expression > Edit Expression 
を選択するか、パラメータ上にマウスを置いて Alt + E を押します。

PYTHON
Python は、CG 業界では統合や標準化をサポートするスクリプト言語
として一般に使われ、よく知られています。その理由から、ツール開発
に向いています。 
Houdini における Python は、Houdini Object Model（HOM）上に 
構築されています。HOM は、Python スクリプト言語を使用して 
Houdini から情報を取得し、制御することができる API です。 
Python では、HOM を定義するモジュール、関数、クラスの階層の 
トップが hou パッケージです。hou モジュールは、パラメータエディタ

や hython コマンドラインシェルでエクスプレッションを記述するときに
自動的にインポートされます。
Houdini でエクスプレッションを記述するのに Python を使用すること
もできます。これには、ノードのパラメータエディタの上部にあるエク
スプレッション言語オプションを変更します。

 

Python コマンドの入力には、Python シェルパネルも使用可能です。 
また、hou モジュールを標準の Python シェルにインポートして、
Houdini を既存の Python ベースのスクリプトに統合することもでき
ます。

ツールシェルフ
シェルフツールは Python でセットアップされています。こうしたコード
を確認するには、任意のシェルフツールを RMB クリックして Edit ツー
ルを選択します。

PYSIDE/PYQT
Python Panel エディタペインでは、PySide2 または PyQt5 イン
ターフェースを作成、編集、削除できます。また、このエディタでは、
Houdini ペインタブメニューのエントリだけでなく、Python Panel の 
インターフェースメニューのエントリも管理できます。このパネルには
サンプルコードがいくつか付属しており、試してみることができます。

PYTHON ステート
Python で Viewer State を記述すると、ビューポート内でのノードに 
対するユーザ操作をカスタマイズできます。これを利用して、アーティ
ストフレンドリーなインターフェースをツールに構築できます。詳細な
情報は、ドキュメントを参照してください。
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VEX
VEX はハイパフォーマンスなエクスプレッション言語で、シェーダの記
述など、Houdini のほとんどの場所で使われています。VEX 評価は、
一般に非常に効率的で、コンパイル済み C/C++ コードに近いパフォー
マンスを発揮します。 
VEX はスクリプトの代用ではありませんが、シェーダやカスタムノード
を記述するために使う、小さくて効率的な汎用言語です。VEX は大ま
かには C 言語ベースですが、RenderMan シェーディング言語と同様
に C++ の考え方を採用しています。
VEX は、Houdini のさまざまな場所で使われています。
モデリング – VEX SOP により、Point アトリビュートを操作するカスタムサー
フェスノードを記述できます。ポイントを動かしたり、速度を調整したり、色を
変更することができます。さらに、ポイントをグループ化するなど、さまざま
な便利なタスクを実行できます。

レンダリング – Karma と Mantra が、シェーディング計算に VEX を使用して
います。これには、ライトシェーダ、サーフェスシェーダ、ディスプレイスメン
トシェーダ、フォグシェーダが含まれます。

コンポジット – VEX Generator および VEX Filter COP を使用すると、複雑な
カスタム COP を VEX で記述できます。エクスプレッションは C/C++ と同様の
速度で評価し、Pixel Expression COP よりも 1000 倍高速に実行されます。

CHOP– VEX CHOP で CHOP をカスタマイズすることができます。CHOP 関数
は任意の数の入力チャンネルを操作して、任意の方法でチャンネルデータを
処理できます。場合によっては、VEX コードはコンパイル済み C++ コードより
も高速で実行可能です。

ファー – プロシージャルなファーの動作を VEX で実装しています。

VOP
VEX を使いたいが、コードは書きたくない場合には、VOP コンテキスト
でノードベースのインターフェースを使用することができます。このた
めには SOP コンテキストで Attribute VOP ノードを使用し、中に入っ
て VOP を使って VEX コードを作成します。入力ジオメトリを受け取っ
て、それを操作できます。

Parameter VOP を使用すると、SOP レベルで使用する、浮動小数点
のスライダのようなインターフェース要素を構築できます。こうすると、
VOP レベルに戻ることなく VEX コードを実行できます。 

VOP コンテキストは、アーティストがインタラクティブに VEX コード
を作成できるように設計されています。スクリプト経験者にとっては、
Wrangle ノードに直接コードを記述する方が合理的かもしれません。

WRANGLE ノード
VEX を使い慣れたユーザがアトリビュートを微調整する低レベルの 
Attribute Wrangle ノードを含む、Wrangle ノードを使用することも
できます。チャンネル、ボリューム、変形を扱う Wrangle ノードもあり
ます。 

Wrangle ノードの使用方法を知りたい場合は、Entagma.com をご覧
ください。コンテンツを作成する、より技術的なアプローチを学習でき
ます。アーティストの考え方も取り入れた、素晴らしいチュートリアル
がいくつも提供されています。 

コンパイルブロック
ジオメトリネットワーク（SOP）では、ネットワークの一部をコンパイル
ブロックに含めることで、コードを記述した場合と同じくらい効率的に
機能させることができます。ネットワークの働きにはいくらか制約が 
課されるとはいえ、適切な状況で使うと、大きなメリットを得られます。

HOUDINI DEVELOPMENT KIT | HDK
Houdini をさらに深く活用するには、HDK があります。HDK は、
SideFX のプログラマーが Houdini ファミリー製品の開発に使用してい
るのと同じ C++ ライブラリの包括的なセットです。HDK を使用すると、
Houdini インターフェ-スのさまざまな領域をカスタマイズできるプラグ
インを作成できます。ここでは、開発キットの用途の例をいくつか紹介
します。

	� カスタムのエクスプレッション関数を追加する
	� カスタムのコマンドを追加する（hscript または HOM）
	� カスタムのオペレータを追加する（SOP、COP、DOP、VOP、ROP、CHOP、

Object）
	� 非標準のレンダラをサポートする出力ノードを追加する
	� カスタムのライティングや大気効果をレンダラに追加する

HDK の詳しい使い方は、SideFX の Web サイトにアクセスし、
Support > Documentation > HDK を選択してください。
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タスク
Task Operator（TOP）を使用すると、タスクを整理およびスケジューリングし、インテリジェントに演算ファームに 
分散できます。これにより、各タスクとタスクの進行状況との関連を示すディペンデンシーグラフを維持しながら、 
データを並列で処理することができます。 

Procedural Dependency Graph
TOP は、Procedural Dependency Graph を使用して構築された 
Houdini のネットワークタイプです。Procedural Dependency Graph 
とは、複雑な依存関係をノードで視覚的に記述するテクノロジで、 
実行可能なタスクセットを生成し、スケジューラの助けを借りて演算
ファームに分散させます。結果を評価したら、ネットワーク全体を再
クックしなくても、グラフの一部に変更を加えることが可能です。

TOP ノード
タスクまたは TOP ノードを使用すると、パイプラインのタスクを管理で
きます。各タスクの並列処理と分散が最終的な目的です。TOP ノード
がタスクを生成すると、そのタスクはドットで表示されます。タスクが
クックされると、このノードや子 TOP ノードで新しいタスクが実行され
ます。

スケジューラ
スケジューラ系ノードは、必要な依存関係を満たしたタスクを受け取
り、計算リソースを割り当てます。各タスクが完了すると、スケジュー
ラはタスクグラフに通知します。タスクグラフが PDG グラフに通知す
ると、次の対象タスクに移行します。PDG は、HQueue、Deadline、
Tractor などの業界標準のスケジューラや、Python で記述したスケ
ジューラをサポートしています。

TOP ノードのクック
タスクグラフができたら、ノードをクックします。グラフの途中でノード
をクックすることも、チェーンの終端の出力ノードをクックすることも 
可能です。

	� Cook Selected Node	 Shift + G
	� Dirty and Cook Selected Node	 Shift + V

進捗状況は、タスクバーで確認できます。TOP ノードでは、タスクのドッ
トを RMB クリックして、そのタスクをクックするか Dirty（変更あり）に
するかを選択できます。タスクを Dirty（変更あり）にすることとは、ネッ
トワークを再クックすると、それらのタスクが再計算されることを意味
します。クリーンなタスクは再クックされません。完了した作業をやり
直す必要がないことは、TOP のメリットの 1 つです。

依存関係
グラフ内のタスクのドットをクリックすると、そのタスクが依存している
上流のタスクと、そのタスクに依存している下流のタスクにつながって
いる細いラインが表示されます。 
上流で変更があった場合、タスクは自動的に Dirty（変更あり）になり、
依存関係がある下流のタスクも Dirty（変更あり）になります。PDG グラ
フが効果的なパイプラインツールとして機能するための、重要なプロ
セスです。

ノードを RMB クリック....

TOP ノード
入力 - ノードは、入力に供給される情報を受け取り、
データごとに 1 つのタスクに分割します。

進捗ホイール - 完了、クック中、未開始（キュー）の
タスクの数を表示します。

TOP ノード - これは、現在クック中のノードです。 
実行されているタスクに対する指示を含みます。
ノードを RMB クリックすると、サポートされるアク
ションのメニューが表示されます。

タスク - 各タスクは小さいドットとして示されます。
色は現在の状態を示し、タスクのドットを RMB ク
リックすると、グラフのその部分について詳細を確
認することができます。

出力 - タスクが完了すると、このノード上の他の 
タスクがまだアクティブであっても、出力は次の 
ノードに結果を渡します。

42

HO
UD

IN
I F

OU
ND

AT
IO

NS



Task Graph Table
ノードを RMB クリックすると、Open Task Graph Table を選択でき
ます。Task Graph Table には、タスクが項目別にリストされ、インデッ
クス、状態、クック時間、優先度などの情報も確認できます。このウィ
ンドウの項目をクリックすると、ネットワークビューではノード上のタス
クのドットがハイライトされます。

データのインポート/エクスポート
TOP グラフにデータを取り込む際は、さまざまなオプションを使用し
て、ジオメトリ、画像、スクリプトなどのデータにアクセスできます。
Houdini デジタルアセットを使用してプロシージャルネットワークを 
適用したり、Houdini の他の部分と接続してデータをインポートしたり
エクスポートすることが可能です。

WEDGE ノード
PDG の重要なワークフローである Wedge 化により、デザインの複数
のイテレーションを素早く作成できます。その後、すべての異なるオプ
ションを TOP グラフで処理し、最後に収集して最終的な出力を作成で
きます。 

画像モザイクと動画の出力
TOP では、ImageMagik を使用してコンタクトシートを作成できます。
コンタクトシートを使用すると、デザインのイテレーションを評価して
最適な選択をしたり、シーンを彩るプロップのバリエーションを生成す
ることができます。また、オーバーレイを使用してネットワークから情
報を引き出すことで、最善の判断を下しやすくなります。

他のアプリとの統合
TOP には、Shotgun や Autodesk Maya などの他のアプリケーション
と連携するためのノードが含まれています。ネットワークを Houdini 外
に拡張し、パイプラインのすべての部分を補強できます。

Pilot PDG アプリケーション
TOP ネットワークは、Houdini 内からセットアップおよび実行できます
が、ファームの管理者や、TOP ネットワークの作成に特化したパイプラ
イン TD は PilotPDG を使用できます。Houdini に関連するタスクにつ
いては、非グラフィカルで動作する Houdini Engine を呼び出して実行
します。

TOP ネットワーク
このネットワークタイプでは、処理
されるネットワークを管理および
確認できます。

タスクバー - ネットワークを開始
および停止したり、進捗を確認で
きます。

ネットワークパス - グラフがセット
アップされている TOP ネットワー
クまでのパスが表示されます。

TOP メニュー - TOP ネットワーク
を整理したり処理するための各種
オプションがあります。

進捗バー - ネットワークタスク全
体の進捗を確認できます。

TOP ノード - これらのノードは、
特定のコマンドをタスクに変換し、
スケジューラで送信することでタ
スクを完了します。

依存関係ライン - タスクをクリック
すると、ネットワーク上の他のタス
クとの接続を確認できます。

スケジューラ - スケジューラ系 
ノードは、データがどこで処理さ
れ、いくつのノードが関与するかを
決めます。

完了したタスク - ノードがすべ
てのタスクの処理を完了すると、
チェックマークが付加されます。

進行中のタスク - 進行中には、 
まだ完了していないタスクを確認
できます。

43

タ
ス

ク



HOUDINI デジタルアセット　
プロシージャルなツール構築
ノードネットワークは、Houdini にプロシージャルな性質を与え、繰り返し適用可能なレシピを定義します。 
Houdini デジタルアセットを使用すると、これらのネットワークをラップして、カスタムツールやスマートアセットを 
作成できます。このようにしてアーティストが構築したツールは、何度でも繰り返し使用でき、スタジオ全体の 
生産性を向上します。

Houdini のノードベースのワークフローが優れている点の 1 つは、 
アーティストが同じ手順を繰り返すのではなく、既存のノードネットワー
クに変更を加えることで複数のイテレーションを生成できることです。
プロセス全体をはじめからやり直すことなく、いくつものユニークな 
結果を得られます。 
Houdini デジタルアセットはこれをさらに一歩進め、1 つまはた複数
のネットワークを単一のノードにカプセル化し、パラメータをトップレベ
ルにプロモートします。このノードはディスクに保存され、作成された
ファイルは共有可能で、他のアーティストがそれぞれのシーンにロード
できます。

アーティストが構築するツール
Houdini デジタルアセットは、Houdini のインタラクティブなツールを
使用して作成します。ノードからアセットプロパティパネルにパラメータ
をドラッグすることで、ハイレベルなインターフェースを構築でき、コー
ドを記述することなく、カスタムツールを作成できます。つまり、テクニ
カルアーティストたちはカスタムツールを構築し、それを手軽に同僚に
使ってもらうことができるわけです。 
Houdini デジタルアセットは、階段や家具などのプロシージャルな 
プロップや、爆発などのビジュアルエフェクトの場合もあれば、サーフェ
ス上にオブジェクトをばら撒くポピュレートツールなどの汎用的なツー
ルである場合もあります。現在のプロジェクト専用のコンテンツを作成
するにしても、すべてのプロジェクトに使える大規模なツールセットを
構築するにしても、それぞれの制作ニーズに応じた Houdini デジタル
アセットのコレクションを構築できます。 

パイプラインフレンドリー
Houdini デジタルアセットがシーンファイルにロードされると、ディスク
上の .hda ファイルを参照します。つまり、アセットに加えられた変更
は、そのファイルを参照しているすべての人に自動的に取得されます。 
このため、パイプライン全体で、変更を反映するのが非常に簡単です。
ディスク上の 1 つのアセットを参照するだけで、最新のイテレーション
で更新されたら、即座に新しいアセットにアクセスできるわけです。
Houdini デジタルアセットファイルが格納できるのはアセット定義だけ
ではありません。アセットで使用される画像、ジオメトリファイル、スク
リプトも保存できます。したがって、他の人がアセットを使用する際は、
関連するすべての情報を利用できます。

CONTENT LIBRARY と ORBOLT
Content Library は、完全なシーンファイル、完全にリギングされた
プロップ、レンダリング可能なビジュアルエフェクト、アニメート可能な
キャラクタ、ゲームアセットなど、2D および 3D アセットを備えたオン
ラインアセットリポジトリです。アクセスするには、SideFX の Web サイ
トで Get > Content Library を選択します。 
Orbolt は、多種多様なデジタルアセットを提供する、オンラインのア
セットマーケットプレイスです。Houdini には、作業時に使えるように、
ダウンロードまたは購入した Orbolt アセットを保存しておくためのパ
ネルがあります。

.hda ファイル

デジタルアセットの作成
Houdini

Houdini

デジタルアセット 
として保存

1	 Houdini でノードと 
ネットワークを作成します。

2	ネットワークをパッケージ化し、他のアーティストと
共有可能な Houdini デジタルアセット（.hda） 
ファイルとして保存します。

4	アセットを使用するには、.hda ファイルを 
Houdini に再度ロードします。 

アセットレベルにプロモートされたパラメータの
み使用できます。他のすべてのパラメータはロッ
クされます。

同じアセットを複数の Houdini シーンで何度でも
使用できます。HDA ファイルに変更を加えると、
他のすべてのアセットも簡単に同期されます。

3	パラメータとハンドルをアセットのトップレベルに 
プロモートすることで、アセットのインターフェース
を構築します。 
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HOUDINI ENGINE
他のアプリとの共有
Houdini Engine を使用すると、Houdini のプロシージャルなノードベースのアプローチを使い慣れたアプリケー
ションに取り込めます。このテクノロジを利用して Houdini デジタルアセットを共有すれば、同僚は Autodesk® 
Maya® や 3ds Max® などの 3D アプリケーションや、Unity® や Unreal® といったゲームエディタに直接アセットを
ロードできます。

他のアプリケーションを使用しているアーティストが 
Houdini デジタルアセットのメリットを享受できるの
は、Houdini Engine プラグインのおかげです。Houdini 
Engine API で作成されたプラグインにより、.hda ファイ
ルとすべてのハンドルおよびコントロールをホストアプリ
ケーションにロードできます。アセットでパラメータが設
定されると、Houdini は「内部」でノードとネットワークを
クックし、その結果をホストに返します。

HOUDINI ENGINE API
これを実現しているのが Houdini API で、API を利用し
てホストアプリケーション向けのプラグインが作成され
ています。HAPI は、フラットかつ小規模な API で、習得
も簡単です。独自のプラグインを作りたい開発者向けに、
Github で提供されています。

HOUDINI ENGINE プラグイン
Houdini インストーラから、またはオンラインでアクセスできる 
Houdini Engine プラグインがいくつかあります。プロダクション環境で
実証済みのこれらのプラグインなら、アーティストやスタジオは安心し
て利用できます。
各プラグインは、一般的な Houdini アセットの機能とホストアプリケー
ションの仕組みの間を橋渡しするように設計されています。例えば、 
ボリュームを使用するクラウドアセットは、Maya では問題なく機能 
するものの、ボリュームがサポートされていない Unity や Unreal では 
解釈されません。

無償の Houdini Engine for Unity/Unreal または無償の Houdini 
Engine Indie ライセンスで動作するプラグイン:

	� Unreal
	� Unity

Houdini Engine ライセンスまたは無償の Houdini Engine Indie  
ライセンスで動作するプラグイン:

	� Autodesk Maya
	� Autodesk 3ds Max 
	� 独自開発のプラグイン

Houdini Engine を使用して Autodesk Maya にロードされた Houdini デジタルアセット

HOUDINI ENGINE パイプライン

Houdini
Engine

ホスト 
アプリケーション

Houdini 
ライブラリ

Houdini

デジタルアセット

をロード

.hda ファイル1	 Houdini Engine プラグインを使用して、 
.hda ファイルをホストアプリケーションに
ロードします。

3	Houdini Engine が Houdini ライブラリ
ファイルをコールし、アセット内のノード
とネットワークを「クック」します。 

4	アセットがロードされたり、パラメータが
変更されると、Engine は Houdini ライブ
ラリを取得し、ノードをクックしてから、 
結果をホストに返します。 

2	ホストアプリケーションが、Houdini Engine 
を使用してアセットとインターフェースを 
受け取ります。

Houdini Engine プラグインが動作する 
ホストアプリケーション
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映画および TV のパイプライン
アニメーションと VFX
実写プレートにビジュアルエフェクトを施すにしても、フル CG のショットを作成するにしても、映画や TV プロジェク
トの最終目標は動画です。動画の映像は、キャラクタ、セット、エフェクトなどのアセットを最終的なコンポジットで 
1 つにまとめあげることで、作られています。

Houdini は、映画および TV 番組制作パイプラインの全段階に使える、
フル機能のパッケージです。モデリングからレンダリング、アニメーショ
ン、最終的なコンポジットまで、Houdini にはクリエイティブなプロセ
スを支えるプロシージャルなツールが搭載されています。長年にわた
り、Houdini が業界標準になっているのは VFX の分野です。SideFX は、
アカデミー賞でのオスカー獲得をはじめ、科学技術部門での賞をいく
つも受賞しています。
プロシージャルモデリング、ライティング、キャラクタ作成といった分野
も強化されており、スタジオからは熟練の Houdini アーティストを求
める声が高まっています。

HOUDINI CORE / HOUDINI FX
パイプラインで使用する Houdini には、2 つの商用バージョンがありま
す。Houdini Core は DOP を除くすべての Houdini ツールを搭載し、
Houdini FX は完全なツールセットを搭載しています。Houdini FX で 
作成したシーンや VFX は、Houdini Core でステージング、アニメート、
ライティング、レンダリングが可能です。FX アーティストは Houdini FX 
ライセンスで、それ以外のユーザは Houdini Core ライセンスを使用す
ることで、堅牢なパイプラインが得られます。 
例えば、シニアテクニカルディレクターが Houdini FX を使用して特定
のプロダクションの課題を解決し、その結果のノードとネットワークを 
Houdini デジタルアセットにラップする使い方があります。アーティスト
フレンドリーな UI を構築し、アニメータや VFX アーティストがコスト効
率のよい Houdini Core でショットを作るのを支援します。 

相互運用性
ほとんどのスタジオは、多種多様な 3D アプリケーションを使用して、
パイプラインの各領域に対処しています。Houdini には、異なるアプ
リケーション間でデータをやり取りできるようにする、相互運用性に優
れたツールが多数あります。USD、Alembic、FBX、EXR のどれを使用
していても、アーティストはさまざまな DCC アプリケーション間を簡
単に行き来できます。また、Houdini Engine プラグインを使用すると、
アセットのプロシージャルなコントロールを保持したまま、Autodesk® 
Maya® や 3ds Max® などのアプリケーションに Houdini デジタルアセッ
トを取り込むことができます。
小規模なスタジオで、短納期に対応するプロダクションでは、大規模
なファイル交換は避けたいことでしょう。フル機能のプロシージャルな
既成パイプラインである Houdini なら、すべての段階を扱えます。 

レンダリングとシミュレーションの分散
画像のレンダリングや VFX のシミュレーションは、時間がかかる処理で
す。フォトリアリスティックな結果を得たい場合には、さらに長い時間
を要します。Houdini では、Houdini Engine のバッチモードを使用し
て、レンダリングおよびシミュレーションタスクを演算ファームに分散さ
せることができます。
シミュレーションの分散により、短時間で結果が得られるだけでなく、
1 台のコンピュータではメモリ不足が懸念されるようなエフェクトも処
理できます。シミュレーションをスライスして分散させることで、最終的
な結果に妥協することなく、メモリを管理できます。Houdini Engine 
を使用して、ファームでシミュレーションを実行することを強くお勧めし
ます。

映画および TV のパイプライン

Render
 VFX

 Layout Animate Light Render Composite

Lighting
 VFX

Simulate
 VFX

Animate
 VFX

 

 

 

Distribute
Sims

Distribute
Render

Distribute
Render

Particles and 
Dynamics

RigModel

Houdini FX

Houdini CORE
Karma Render/Mantra

Houdini Engine

USD, FBX, OBJ, EXR etc...

File Transfer
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ゲーム開発および VR のパイプライン
インタラクティブ体験
ビデオゲームやバーチャルリアリティのプロジェクトで重視なのは、スムーズなゲームプレイ体験を実現するよう 
高度に最適化されたコンテンツを使用して、インタラクティブな 3D 世界を構築することです。映画に似たゲーム 
シネマティクスのレンダリングとは、異なるタイプのパイプラインを用いることになります。 

ゲームパイプラインの中核は、Unreal や Unity などの
ゲームエンジンです。これらのエンジンが、ゲームアート
とゲームインタラクションを統合し、プレイ可能な体験を
作り出します。ゲームアーティストは Houdini を使用し
て、地形の作成、レベルの設計と配置、プロシージャル
モデルの構築、キャラクタの構築とアニメーション、火、
流体、破壊などのリアルタイム FX の作成を行うことがで
きます。

ゲームエンジンへのエクスポート
Houdini からゲームエンジンにコンテンツを取り込むに
は、2 通りの方法があります。従来は、FBX や OBJ といっ
たファイルフォーマットにエクスポートし、それをエンジン
にインポートしていました。Houdini でプロシージャルな 
システムを作成し、その結果を平坦化します。
もう 1 つの方法は、Houdini デジタルアセットを作成し、Unreal や 
Unity 向けの Houdini Engine プラグインを使用してゲームエンジン
にロードすることです。これらのアセットは、パラメータやコントロール
を保持したまま、ゲームエディタにインポートされます。ゲームエディ
タ内で変更を加えることができ、Houdini Engine がバックグラウンド
で動作してアートワークを更新します。
ゲームアーティストはエディタ内でこのプロシージャ性を活用で
き、ゲームをコンパイルする際に、アートワークがベイクされます。
Houdini Engine はランタイムソリューションではないため、ゲームプレ
イの一部としてアクセスすることはできません。 

リアルタイム FX
Houdini は VFX で知られており、ゲームの FX 作成に最適なツールで
す。しかし、FX は、テクスチャシート、フローマップ、頂点アニメーショ
ンテクスチャなどのテクニックを用いて最適化する必要があります。 
エフェクトのフットプリントを可能な限り軽くすることで、ゲームの 
フレームレートが保持され、コマ落ちも起きません。本ドキュメントで
紹介し たSideFX Labs ツールは、このようなワークフローをサポートす
るよう設計されています。

Houdini Engine を使用して Unreal にロードされた Houdini デジタルアセット

ゲーム開発および VR のパイプライン Houdini FX

Houdini CORE
Game Engines/Other Apps

Houdini Engine Plug-ins

FBX, OBJ, USD, EXR etc...

File Transfer
Maya/

3DS Max

AnimateRigModel

 

Procedural
Modeling

Level 
Design

Export

Game
Engine

Realtime FX

Play Game

Compile/
Bake Assets

Save as
HDA

 

Terrain
Generation

Populate
Environment
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製品とライセンス
Houdini を使い始めるにあたり、Houdini 製品の種類を知っておくと
役立ちます。大規模なスタジオ、小規模なスタジオ、新たに立ち上げ
た独立系（インディ）制作チームなど、それぞれのニーズに応じた各種 
Houdini 製品があります。また、学校のラボや無償で学習したい学生
のための Houdini もあります。 

商用ライセンス 
Houdini Core – モデラー、ライティングアーティスト、キャラクタリグ
ガー、アニメータ、ゲームアーティスト向けに設計され、コンポジティ
ングやモーション編集などの機能も搭載しています。Houdini FX で作
成したシーンは、Houdini Core で開いてレンダリングできるため、VFX 
のライティングに最適です。
Houdini FX – Houdini FX は、Houdini Core に含まれるすべてのツー
ルに加えて、パーティクルおよびダイナミックシミュレーションツールも
搭載しています。Houdini FX のプロシージャルワークフローを使用す
ると、流体、Pyro FX、粒、布、ヘアとファー、群衆、ソフトボディエフェ
クトなどを作成できます。
Houdini Engine – Houdini Engine は、コマンドラインからバッチモー
ドで実行し、レンダリングや分散ダイナミックシミュレーションを一括
で処理することができます。また、Autodesk® Maya®、Autodesk® 3ds 
Max®、Unity®、Unreal® をはじめ、他のデジタルコンテンツ作成アプリ
ケーションに Houdini デジタルアセットをロードするときにも Houdini 
Engine が使用されます。

INDIE ライセンス
Houdini Indie - 起業したばかりのアニメータやゲーム制作者に、
Houdini のアニメーションおよび VFX ツールのすべてを提供します。
Houdini Indie の商用利用は、約 1000 万円以下の収益に制限されて
います。 
Houdini Engine Indie – Houdini Engine Indie ライセンスを使用す
ると、Houdini Indie をバッチモードで実行したり、Houdini デジタル
アセットを他のコンテンツ作成アプリにロードすることができます。

ライセンスについて
Houdini Education – Houdini Education は、学校、トレーニングセ
ンター、学生による使用を目的として設計された、Houdini FX のフル
機能バージョンです。Houdini Education では、Houdini Apprentice 
で作成したファイルを開くことができます。
Houdini Apprentice – Houdini Apprentice は、Houdini FX の無料
体験バージョンで、学生、アーティスト、ホビーユーザが非商用目的の
個人プロジェクトに使用できます。受賞歴のある Houdini FX のほぼす
べての機能にアクセスできるので、スキルの強化や個人プロジェクトに
役立ちます。Apprentice ではディスクにシーンを保存可能ですが、レ
ンダリング画像にはウォーターマークが追加されます。

注意 : Indie、Apprentice、Education で作成したシーンファイル
とアセットは、商用バージョンの Houdini では使用できません。ファ
イルフォーマットが異なるうえ、異なるライセンスタイプ間でのファイ
ル共有は EULA（エンドユーザー使用許諾契約書）で認められていま
せん。

ライセンスタイプ
ワークステーション（ノードロック） – このライセンスタイプは 1 台の 
コンピュータ上で使用でき、ローカルサーバーまたは SideFX.com  
からのみアクセス可能です。
ローカル / グローバルアクセス（フローティング） – これらのライセンス
はサーバー上にセットアップでき、アーティストチームで共有可能です。
アーティストが Houdini を起動すると、利用可能なライセンスがある
場合、ライセンスがサーバーからチェックアウトされます。ローカルラ
イセンスは単一のスタジオ向けで、グローバルライセンスは異なる場
所にあるスタジオで共有することを目的に設計されています。

ライセンスのインストール
ライセンスを取得したら、Houdini License Administrator（hkey）
アプリケーションを開き、File > Install Licenses を選択して、ライセ
ンスをインストールします。ログインとパスワードの入力を求められま
すが、これは SideFX.com の Web サイトで設定したものと同じです。 
ローカルにインストールするのではなく、sidefx.com をライセンスサー
バーとして使用できるようになりました。ログインライセンスを使用す
るには、常に SideFX アカウントでログインしている必要があります。
異なるコンピュータを使ってログインすることもできますが、一度に使
用できるのは 1 台のみです。この方法は、独立系制作者や学生ユーザ
に最適です。 
ローカルおよびグローバルアクセスライセンスは、この方法で中央
サーバーにインストールできます。ライセンスにアクセスする全員が、
そのサーバーを利用できるようにする必要があります。 
また、ライセンスを確認したい場合は、SideFX.com の Web サイト
の右上に表示されるアバターをクリックし、Services を選択して、
Manage Licenses リンクをクリックします。

年間アップグレードプラン（AUP）
Houdini への投資を最大化する年間アップグレードプラン（AUP）は、
ビジュアルエフェクトスタジオ、ゲームスタジオ、3D アーティストに重
要な特典を提供します。プロダクションレベルのテクニカルサポート、
最新のソフトウェア機能強化を含むフルリリースとドットリリース、バグ
修正を含むデイリービルドなどをご利用いただけます。 

SIDEFX サポート
Apprentice ユーザを含むすべてのお客様は、インストールやライセン
スに関する問題について、メールサポートシステムで SideFX にお問い
合わせいただけます。複雑なプロダクションに関する問題や質問は、
年間アップグレードプランおよび商用レンタルのお客様のみ、サポート
チームに問い合わせが可能です。
弊社のサポート担当窓口は、support@sidefx.com です。 
次の情報をメールに含めてください。

	� お使いのオペレーティングシステム（Windows XP など）
	� Houdini のバージョンおよびビルド番号
	� インストールの問題の概要、ライセンスの問題がある場合には 

診断ファイル

サポートプロラムの詳細については、SideFX.com/support をご覧く
ださい。
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商 用 独立系（インディ） 学 習

製品 HOUDINI FX HOUDINI CORE HOUDINI INDIE EDUCATION APPRENTICE

対象ユーザ スタジオ | 商業アーティスト 独立系 | フリーランス 学校 | 学生 ホビーユーザ

価格 SideFX.com を参照 1 年間 $269 USD 1 年間 $75 USD 無償

オペレーティングシステム Windows、LINUX、Mac OSX

モデリング     

キャラクタ     

アニメーション     

Solaris : レイアウトツール     

Solaris : ルックデブとライティング     

Karma/Mantra レンダリング     

地形     

合成     

ボリューム     

Pyro FX  Simple Fireball   

流体  シンプルな Flip   

リジッドボディ  Simple Fracture   

パーティクル  -   

Vellum Cloth  Simple Cloth   

ワイヤーダイナミクス  -   

群衆  -   

ライセンス 商用 限定的な商用 非商用
ワークステーション（ノードロック）    - 

ローカル/グローバルアクセス（フローティング）   -  -

ユーザインターフェース

Houdini GUI アクセス     

コマンドラインアクセス     

GUI ウォーターマーク - - 透かし入り（小） 透かし入り（小） 透かし入り（小）

プラグインサポート     

HOUDINI ENGINE

HOUDINI ENGINE プラグイン     なし

Engine 用アセット作成     Education ライセンス用

Orbolt 用アセット作成     

レンダリング

Karma トークン 5  / 10* 5 / 10* 1 10 1

Mantra トークン 無制限 無制限 1 10 1

サードパーティ製レンダラ     なし

ウォーターマーク付きレンダリング - - - - 

解像度 無制限 無制限 無制限 無制限 1280 x 720

シーン

.hip   .hipalc .hipanc .hipanc

.hda   .hdalc .hdanc .hdanc

ジオメトリ

USD     .usdnc

FBX     インポート

Alembic     インポート

.bgeo     

画像

.pic   .piclc  .picnc

.exr     ウォーターマーク付き

.tif     ウォーターマーク付き

.png/.jpg     ウォーターマーク付き

機
能

フ
ォ

ー
マ

ッ
ト

比較表 

* 商用のワークステーションライセンスには Karma トークンが 5 つ付属し、ローカルおよびグローバルアクセスライセンスには Karma トークンが 10 個付属しています。
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